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1 Introduction to Polyspace® Products for Verifying C/C++ Code

Product Overview

In this section...

“Polyspace Client for C/C++” on page 1-2

“Polyspace Server for C/C++” on page 1-2

Polyspace Client for C/C++
Prove the absence of run-time errors in source code

Polyspace® Client™ for C/C++ provides code verification that proves the
absence of overflow, divide-by-zero, out-of-bounds array access, and certain
other run-time errors in source code using static code analysis that does not
require program execution, code instrumentation, or test cases. Polyspace
Client for C/C++ uses formal methods-based abstract interpretation
techniques to verify code. You can use it on handwritten code, generated code,
or a combination of the two, before compilation and test.

Support for industry standards is available through IEC Certification Kit (for
ISO 26262 and IEC 61508) and DO Qualification Kit (for DO-178).

Key Features

¢ File- and class-level software component verification
® Formal method based abstract interpretation
¢ Display of run-time errors directly in code

e MISRA-C:2004, MISRA-C++:2008, and JSF++ coding standard
enforcement, with direct source file links

® Cyclomatic complexity and other code metrics

e Eclipse™ and Microsoft® Visual Studio® IDE integration

Polyspace Server for C/C++
Perform code verification on computer clusters and publish metrics

Polyspace Server™ for C/C++ provides code verification that proves the
absence of overflow, divide-by-zero, out-of-bounds array access, and certain


http://www.mathworks.com/products/iec-61508
http://www.mathworks.com/products/do-178

Product Overview

other run-time errors in source code. For faster performance, Polyspace Server
for C/C++ lets you schedule verification tasks to run on a computer cluster.
Jobs are submitted to the server using Polyspace Client for C/C++. You can
integrate jobs into automated build processes and set up e-mail notifications.
You can view defects, regressions, and code metrics via a Web browser. You
then use the client to download and visualize verification results.

Support for industry standards is available through IEC Certification Kit (for
ISO 26262 and IEC 61508) and DO Qualification Kit (for DO-178).

Key Features

® Web-based dashboard providing code metrics and quality status
¢ Automated job scheduling and e-mail notification
e Multi-server job queue manager

® Accelerated performance on multicore servers

Verification report generation

Mixed operating system environment support

1-3
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Polyspace Verification

In this section...

“Overview of Polyspace Verification” on page 1-4

“The Value of Polyspace Verification” on page 1-4

Overview of Polyspace Verification

Polyspace products verify C, C++, and Ada code by detecting run-time errors
before code is compiled and executed.

To verify the source code, you set up verification parameters in a project, run
the verification, and review the results. A graphical user interface helps you
to efficiently review verification results. Results are color-coded:

® Green — Indicates code that never has an error.

¢ Red — Indicates code that always has an error.

® Gray — Indicates unreachable code.

U — Indicates unproven code (code that might have an error).

The color-coding helps you to quickly identify errors and find the exact

location of an error in the source code. After you fix errors, you can easily run
the verification again.

The Value of Polyspace Verification

Polyspace verification can help you to:

¢ “Ensure Software Reliability” on page 1-4
® “Decrease Development Time” on page 1-5

® “Improve the Development Process” on page 1-6

Ensure Software Reliability

Polyspace software ensures the reliability of your C and C++ applications by
proving code correctness and identifying run-time errors. Using advanced



Polyspace® Verification

verification techniques, Polyspace software performs an exhaustive
verification of your source code.

Because Polyspace software verifies all possible executions of your code, it
can identify code that:

e Never has an error

Always has an error

Is unreachable

Might have an error

With this information, you know how much of your code is free of run-time
errors, and you can improve the reliability of your code by fixing errors.

You can also improve the quality of your code by using Polyspace verification
software to check that your code complies with established coding standards,
such as the MISRA C®, MISRA® C++ or JSF++ standards.’

Decrease Development Time

Polyspace software reduces development time by automating the verification
process and helping you to efficiently review verification results. You can use
it at any point in the development process. However, using it during early
coding phases allows you to find errors when it is less costly to fix them.

You use Polyspace software to verify source code before compile time. To
verify the source code, you set up verification parameters in a project, run
the verification, and review the results. This process takes significantly less
time than using manual methods or using tools that require you to modify
code or run test cases.

Color-coding of results helps you to quickly identify errors. You will spend
less time debugging because you can see the exact location of an error in the
source code. After you fix errors, you can easily run the verification again.

1. MISRA and MISRA C are registered trademarks of MISRA Ltd., held on behalf of the
MISRA Consortium.
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Using Polyspace verification software helps you to use your time effectively.
Because you know which parts of your code are error-free, you can focus on
the code that has definite errors or might have errors.

Reviewing code that might have errors (orange code) can be time-consuming,

but Polyspace software helps you with the review process. You can use filters
to focus on certain types of errors or you can allow the software to identify the
code that you should review.

Improve the Development Process

Polyspace software makes it easy to share verification parameters and
results, allowing the development team to work together to improve product
reliability. Once verification parameters have been set up, developers can
reuse them for other files in the same application.

Polyspace verification software supports code verification throughout the
development process:

¢ An individual developer can find and fix run-time errors during the initial
coding phase.
® Quality assurance engineers can check overall reliability of an application.

¢ Managers can monitor application reliability by generating reports from
the verification results.



Product Components

Product Components

In this section...

“Polyspace Verification Environment” on page 1-7

“Other Polyspace Components” on page 1-10

Polyspace Verification Environment

The Polyspace verification environment (PVE) is the graphical user interface
of the Polyspace Client for C/C++ software. You use the Polyspace verification
environment to create Polyspace projects, start verifications, and review
verification results.

The Polyspace verification environment consists of two perspectives:
® “Project Manager Perspective” on page 1-7

e “Results Manager Perspective” on page 1-9

Project Manager Perspective

The Project Manager perspective allows you to create projects, set verification
parameters, and start verifications.
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You use the Project Manager perspective in the tutorial in Chapter 2, “Setting
Up a Polyspace Project”.
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Results Manager Perspective
The Results Manager perspective allows you to review:

e Results from the Polyspace coding rules checker, to ensure compliance
with established coding standards.

¢ Verification results, comment individual checks, and track review progress.

Check details Review Statistics
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You use the Results Manager perspective in the tutorials in Chapter 5,
“Checking Compliance with Coding Rules” and Chapter 4, “Reviewing
Verification Results”.

Other Polyspace Components

In addition to the Polyspace verification environment, Polyspace products
provide several other components to manage verifications, improve
productivity, and track software quality. These components include:

e Polyspace Queue Manager Interface (Spooler)

e Polyspace in One Click
® Polyspace Metrics Web Interface

Polyspace Queue Manager Interface (Polyspace Spooler)

The Polyspace Queue Manager (also called the Polyspace Spooler) is the
graphical user interface of the Polyspace Server for C/C++ software. You
use the Polyspace Queue Manager Interface to move jobs within the queue,
remove jobs, monitor the progress of individual verifications, and download

results.
Polyspace Queue Manager Interface E\@
Operations Help
D Author Application Results folder CPU Status Date Language

----- 23 |username |example_project |C:\PolySpace\polyspace _project\verification_1\Result_9 |AH-SRUNS... |completed [15-Dec-2010, 16:03:33 |C

s 24 a ] 0 = 0 = ] catio 0 A g O 010, 16:0

25 |username |example_project |C:\PolySpace'polyspace_project\Verification_1'Result_11 gueued  |15-Dec-2010, 16:03:21 |C

Connected to Queue Manager AH-SRUNSTRO.dhcp.mathworks.com User mode

You use the Polyspace Queue Manager in the tutorial “Starting Server
Verification from Project Manager” on page 3-10.
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Polyspace in One Click
Polyspace in One Click is a convenient way to verify multiple files using the
same set of options.

After creating a project with the options that you want, you can use Polyspace
in One Click to designate that project as the active project, and then send
source files to Polyspace software for verification with a single mouse click.

You use Polyspace in One Click in the tutorial “Using Polyspace In One Click
to Launch Verification” on page 3-22.

Polyspace Metrics Web Interface

Polyspace Metrics is a web-based tool for software development managers,
quality assurance engineers, and software developers. Polyspace Metrics
allows you to evaluate software quality metrics, and monitor changes in code
metrics, coding rule violations, and run-time checks through the lifecycle

of a project.

For information on using Polyspace Metrics, see “Software Quality with
Polyspace Metrics”in the Polyspace Products for C/C++ User’s Guide.

1-11
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Installing Polyspace Products

In this section...

“Finding the Installation Instructions” on page 1-12

“Obtaining Licenses for Polyspace® Client™ for C/C++ and Polyspace®
Server™ for C/C++” on page 1-12

Finding the Installation Instructions

The tutorials in this guide require Polyspace Client for C/C++ and Polyspace
Server for C/C++. Instructions for installing Polyspace products are in the
Polyspace Installation Guide. Before installing Polyspace products, you must
obtain the necessary licenses.

Obtaining Licenses for Polyspace Client for C/C++
and Polyspace Server for C/C++

For information about obtaining licenses for Polyspace products, see
“Polyspace License Installation” in the Polyspace Installation Guide.



Working with Polyspace® Software

Working with Polyspace Software

In this section...

“Basic Workflow” on page 1-13

“Tutorials in This Guide” on page 1-14

Basic Workflow

The following graphic shows the basic workflow for using Polyspace software
to verify source code.

Set up project

A4

Verify code

A 4

3
Review verification results

In this workflow, you:

1 Use the Project Manager perspective to set up a project file.

2 Verify code on a server or client.

You can use the Project Manager perspective to start the verification or
you can select files from a Microsoft Windows® folder and send them to
Polyspace software for verification. For verifications that run on a server,
you use the Polyspace Queue Manager Interface (Polyspace Spooler) to
manage the verification and download the results to a client. You can set an
option to check coding rules compliance in the first stage of the verification.

1-13
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3 Use the Results Manager perspective to review verification results.

Tutorials in This Guide
The tutorials guide you through the basic workflow, including the different
options for running verifications. The following graphic shows the workflow

you follow in these tutorials.

Create new project

Review verification results

A 4

4
Check MISRA C compliance

In this workflow, you:
1 Create a new project that you use for the workflow.

This step is in the tutorial in Chapter 2, “Setting Up a Polyspace Project”.

2 Verify a single C file.
This step is in the tutorial in Chapter 3, “Running a Verification”. In this
tutorial, you verify the same file using three different methods of running a
verification:
e Start a verification that runs on a server using the Project Manager

perspective.



Working with Polyspace® Software

® Send files to a server for verification using Polyspace In One Click.

e Start a verification that runs on a client using the Project Manager
perspective.

3 Review the verification results.
This step is in the tutorial in Chapter 4, “Reviewing Verification Results”.

4 Modify the project to include MISRA C checking and review the MISRA C
violations in the example file.

This step is in the tutorial in Chapter 5, “Checking Compliance with
Coding Rules”.

1-15
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Additional Information and Support

In this section...

“Product Help” on page 1-16
“MathWorks Online” on page 1-16

Product Help

To access Polyspace online Help, select Help > Help .

To access the online documentation for Polyspace products, go to:
www.mathworks.com/help/toolbox/polyspace
MathWorks Online

For additional information and support, go to:

www.mathworks.com/products/polyspace

1-16
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Related Products

In this section...

“Polyspace Products for Verifying Ada Code” on page 1-17

“Polyspace Products for Linking to Models” on page 1-17

Polyspace Products for Verifying Ada Code

For information about Polyspace products that verify Ada code, go to:
http://www.mathworks.com/products/polyspaceclientada/
http://www.mathworks.com/products/polyspaceserverada/
Polyspace Products for Linking to Models

For information about Polyspace products that link to models, go to:
http://www.mathworks.com/products/polyspacemodelsl/

http://www.mathworks.com/products/polyspaceumlrh/
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Project

e “About Setting Up a Project Tutorial” on page 2-2

e “Creating a New Project” on page 2-3



2 Setting Up a Polyspace Project

About Setting Up a Project Tutorial

In this section...

“Overview” on page 2-2

“Example Files” on page 2-2

Overview

You must have a project before you can run a Polyspace verification of your
source code. In this tutorial, you create the project that you use to run
verifications in later tutorials.

Example Files

This tutorial uses the source file example.c that comes with the installation.
You learn more about the files and folders required for this tutorial in
“Preparing Project Folders” on page 2-4.



Creating a New Project

Creating a New Project

In this section...

“What Is a Project?” on page 2-3
“Preparing Project Folders” on page 2-4
“Opening Polyspace Verification Environment” on page 2-5

“Creating a New Project to Verify the Example C File” on page 2-7

What Is a Project?

In Polyspace software, a project is a named set of parameters for verification
of your software project’s source files. A project includes:

e Source files

Include folders

® One or more Configurations, specifying a set of analysis options

® One or more Modules, each of which include:
= Source (specific versions of source files used in the verification)
= Configuration (specific set of analysis options used for the verification)
= Verification results

You can create your own project or use an existing project. You create and
modify a project using the Project Manager perspective.

In this tutorial, you create a new project and save it as a configuration file
(.cfg).

2-3



2 Setting Up a Polyspace Project

Preparing Project Folders

Before you start verifying a C file with Polyspace software, you must know
the locations of the C source file and the include files. You must also know
where you want to store the verification results.

For each project, you decide where to store source files and results. For
example, you can create a project folder, and then in that folder, create
separate folders for the source files, include files, and results.

For this tutorial, prepare a project folder as follows:

1 Create a project folder named polyspace_project.

2 Open polyspace_project, and create the following folders:
® sources

e includes

3 Copy the file example.c from
Polyspace_Install\Examples\Demo_C_Single-File\sources
to
polyspace_project\sources
Polyspace Install is the installation folder.

4 Copy the files include.h and math.h from
Polyspace_Install\Examples\Demo_C_Single-File\sources
to

polyspace_project\includes.
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Opening Polyspace Verification Environment

You use the Polyspace verification environment to create projects, start
verifications, and review verification results.

To open the Polyspace verification environment:

1 Double-click the Polyspace icon (Windows systems).

Note On a Linux® or UNIX® system, use the following command:

/usr/local/Polyspace/PVE/bin/polyspace

2 If you have only Polyspace Client for C/C++ software installed on your
computer, skip this step. If you have both Polyspace Client for C/C++ and
Polyspace Client for Ada products on your system, the Polyspace Language
Selection dialog box opens.

Polyspace Language 5election =]
Select 2 language

(% Polyspace for CIC++

" Polyspace for Ada

ok | Cancel |

3 Select Polyspace for C/C++ and click OK.

The Polyspace verification environment opens.
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Specify source files and Set target and specify
include folders verification options

File Edit Run Review Options Window Help
FEeas D| L) l“ % %@|%‘0 .‘ @"Search:| |EPm]E(tManager 2. Results Manager

bR ¥ P Batch Ry

ject Browser figuration - [example_proje

Create new result folder Use result folder: lResu\t_G

Compiler Settings | All Settings
Target Environment
Targetoperang sysem: Targetprocesor tpe
) Compiler Dialect
example_project
53 Configuration B
[ example_project
) Result Compilation Macros Active Settings
£S5 Demo_C[C] +* X x
L Macro Description Option
I Ignore assembly code |-discard-asm
=53 Module 1 llow non it types for bitheids [alon-non-ntbitheld
-3 Seurce Accept integral type confiicts -permissive-ink
3 sources Allow undefined global variables -allow-undef-variables
=3 Configuration Allow anonymous unions/structure fields -allow-unnamed-fields
24 Demo_C-with-MISRA-checker Allow negative operand for left shifts -allow-negative-operand-n-shift | -
|24 Demo_C-without-MISRA-checker
Result § Output Summary
[ Result_1 [Verification Completed]

I% Full Log ‘ i Verification Statistics Progress Monitor Output Summary

b 0% |J Ready

Monitor progress and view logs

By default, the Polyspace verification environment displays the Project
Manager perspective. The Project Manager perspective has three main panes.
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Use this For...
section...

Project Browser | Specifying:
(upper-left) ® Source files

® Include folders

e Results folder

Configuration Specifying verification options
(upper-right)

Output Monitoring the progress of a verification, and viewing
(lower-right) status, log messages, and general verification statistics.

You can resize or hide any of these panes. You learn more about the Project
Manager perspective later in this tutorial.

Creating a New Project to Verify the Example C File

You must have a project, saved with file type cfg, to run a verification. In this

p

art of the tutorial, you create a new project for verifying example.c.

You create a new project by:

“Opening a New Project” on page 2-7

“Specifying Source Files and Include Folders” on page 2-11
“Specifying Target Environment” on page 2-13

“Specifying Analysis Options” on page 2-14

“Saving the Project” on page 2-14

Opening a New Project
To open a new project for verifying example.c:

Select File > New Project. The Polyspace Project — Properties dialog
box opens.
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2 In the Project name field, enter example project.

3 Clear the Default location check box.

Note In this tutorial, you change the location to the project folder that you
created in “Preparing Project Folders” on page 2-4.

You can update the default project location. Select Options > Preferences,
which opens the Polyspace Preferences dialog box. On the Project and
result folder tab, in the Define default project location field, specify
the new default location.

4 In the Location field, enter or navigate to the project folder that you
created earlier.

In this example, the project folder is C: \Polyspace\polyspace_project.

5 In the Project language section, select C .
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-~ Project - Properties @

Define project properties

Project definition and location
Project name: |example_project
Version: | 1.0

Author: username

[ Use default location

Location: |C:\Polyspace'polyspace_project

Project lanquage

@ C

®C++

Compilation Environment

[7] Use template

m
1]

0
~

[ Mext “ Finish |’ Canicel

6 Click Finish.

The example_project opens in the Polyspace verification environment.
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File Edit Run Review Options Window Help

EEEEC R L I - 8]
Run ¥ Batch Run Stop Create new result folder Use result folder: -
[
* Configuration - [ oject [ Module_1 / Configuration [ example_project]
o | + 3 ‘ Compiler Settings | Al Settings
example_project [C] Target Environment
I Source
e Y 7 S—— A
B3 Module_1
1@y Source Compiler Dialect
£33 Configuration
5 example_project Diect:
o fdy Result
Compilation Macros: Active Settings
X X
Macro Description Cption
Ignore assembly code |-discard-asm
Allow non int types for bitfields [allow-nen-int-bitfield
‘Acceptintegral type confiicts. Fpermissiveink
Allow undefined global variables [allow-undef-variables
Allow anonymous unions/structure fields -allow-unnamed-fields
Allow negative operand for left shifts. [allow-negative-operand-n-shift | ~
[& FullLog ‘ B verification Statistics | [l Progress Monitor Output Summary
1 0% 3| Ready
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Specifying Source Files and Include Folders
To specify the source files and include folders for the verification of example.c:

1 In the Project Browser, select the Source folder.

o |

2 On the Project Browser toolbar, click the Add source icon “ . The
Polyspace Project — Add Source Files and Include Folders dialog box opens.

3 The project folder polyspace_project should appear in the field Look in.
If it does not, navigate to that folder.

4 Select the sources folder. Then click Add Source.

The example.c file appears in the Source tree for example project.
5 Select the includes folder. Then click Add Include.

The includes folder appears in the Include tree for example project.
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-~ Polyspace Project - Add Source Files and Include Folders @
Lookin: | |, polyspace_project d i cE Add recursi\rely| sz | + 3
X J includes E"«_J example_project [C]
’;}‘ J sources EIL:"} Source
Recent Items BE‘ e
| example.c
B3 Indude
! {3 C:'Polyspace\polyspace_projectijndudes
Desktop
L
My Documents
[
L
Computer
@
Network -
Files of type: .{“.c) files only - s | Add Incude

Note In addition to the include folders you specify, Polyspace software
automatically adds the standard includes to your project.

6 Click Finish to apply the changes and close the dialog box.

The Project Browser now looks like the following graphic.
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=
=]

" =8 IE-1E
Ell'j' Source
! B3 sources

51 example.c

é--l‘j‘lnclude

EJL'j' Configuration
B example_project

- & Result

Specifying Target Environment

Many applications are designed to run on specific target CPUs and operating
systems. Since some run-time errors are dependent on the target, you must
specify the type of CPU and operating system used in the target environment
before running a verification.

In the Project Manager perspective, the Configuration > Compiler
Settings tab allows you to specify the target operating system and processor
type for your application.

To specify the target environment for this tutorial:

1 From the Target operating system drop-down list, select
no_predefined_0S.

Target Environment

- Target processor type: :i386 -j

Compiler Dialect

Dialect: | none v

2 In the Target processor type drop down menu, select 1386.
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2-14

For more information about emulating your target environment, see “Setting
Up a Target’in the Polyspace Products for C/C++ User’s Guide.

Specifying Analysis Options
In the Project Manager perspective, the Configuration > All Settings tab

allows you to set Analysis options that Polyspace software uses during the
verification process.

For this tutorial, you should use the default values for all options.

Analysis options

[=]-General

----- Send to Polyspace Server
----- Add to results repository

-server

-add-to-results-repository

1 O

----- Keep all preliminary results files “+eep-all-fies
----- Calculate code metrics -code-metrics
[=-Report Generation
i-Report template name Developer -report-template
i..Qutput format RTF -report-output-format

- Target/Compilation

H--Compliance with standards

+|--PredsionScaling
#|--Multitasking

[
[
[#-Polyspace inner settings
[
[E

For more information about analysis options, see “Options Description” in the
Polyspace Products for C/C++ Reference.

Saving the Project
To save the project, select File > Save.

The software saves your project using the Project name and Location that
you specified when creating the project.
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® “About Running a Verification Tutorial” on page 3-2

® “Preparing for Verification” on page 3-4

e “Starting Server Verification from Project Manager” on page 3-10

¢ “Using Polyspace In One Click to Launch Verification” on page 3-22

¢ “Launching Client Verification from Project Manager” on page 3-27
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About Running a Verification Tutorial

In this section...

“Overview” on page 3-2

“Before You Start” on page 3-3

Overview

Once you have created the project example.cfg, as described in “Creating a
New Project” on page 2-3, you can run the verification.

You can run a verification on a server or a client.

Use...

FOI‘...

Server

¢ Best performance

¢ Large files (more than 800 lines of code, including comments)

Client

® When the server is busy

e Small files

Note Verification on a client takes more time. You might
not be able to use your client computer when a verification is
running on it.

You can start a verification using either the Project Manager or Polyspace In
One Click. With either method, the verification can run on a server or a client.
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Use... For...

Project Manager A basic way to start a verification.

You specify the source files in the project file.
With the project open, you click a button to start
the verification.

Polyspace In One Click | A convenient way to start the verification of
several files which use the same verification
options.

Once you specify the project file containing the
verification options, you specify the source files
by selecting them from a Microsoft Windows
folder. You start the verification by sending the
selected files to Polyspace software.

In this tutorial, you learn how to run a verification on a server and on a client,
and how to start a verification using the Project Manager and Polyspace In
One Click. You verify the file example.c three times using a different method
each time. You use:

® Project Manager to start a verification that runs on a server.

¢ Polyspace In One Click to start a verification that runs on a server.

® Project Manager to start a verification that runs on a client.

Each verification stores the same results in your project. You review these
results in the tutorial Chapter 4, “Reviewing Verification Results”.

Before You Start

Before you start this tutorial, you must complete Chapter 2, “Setting Up a
Polyspace Project”. You use the folders and project file, example.cfg, from
that tutorial.
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Preparing for Verification

In this section...

“Opening the Project” on page 3-4
“Specifying Source Files to Verify” on page 3-5

“Checking for Compilation Problems” on page 3-5

Opening the Project

To run a verification, you must have an open project file. For this tutorial, you
use the project file example.cfg that you created in Chapter 2, “Setting Up a
Polyspace Project”. If example project.cfg is not already open, open it.
To open example_project.cfg:
1 If the Polyspace software is not already open, open it.
2 Select File > Open Project.
The Open Polyspace Project dialog box opens.
3 Using the Look in drop-down list, navigate to polyspace_project.

4 Select example project.cfg.

5 Click Open to open the file and close the dialog box.
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Specifying Source Files to Verify

Each Polyspace project can contain multiple modules. With each module, you
can verify a specific set of source files using a specific set of analysis options.

Therefore, before you start a verification, you must specify which files in your
project that you want to verify. In the example project in this tutorial,
there is only one file to verify.

To copy source files to a module:
1 In the Project Browser Source tree, right click example.c.
2 Select Copy Source File to > Module_(1).

The example.c file appears in the Source tree of Module (1).

ALVt +|E
EI,_".I example_project [C]
EI_J Source

EI‘E‘.‘ SOUFCES

S| examplec

=l

El_} Include
L3 CA\Polyspace\polyspace_projectiincludes
&3 Module_1

~IC Source

EHES sources

B

EI_,‘ Configuration

P E example_project

Checking for Compilation Problems

The Compilation Assistant is enabled by default. During a verification, if the
Compilation Assistant detects compilation errors, the verification stops and
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the software displays errors and possible solutions on the Output Summary
tab.

Note The Compilation Assistant does not support the verification option
-unit-by-unit.

To disable the Compilation Assistant, select Options > Preferences, which
opens the Polyspace Preferences dialog box. Then, on the Project and result
folder tab, clear the Compilation Assistant check box and click OK.

To check your project for compilation problems:

1 In the Project Browser tree, right click the Include folder (. .\includes),
then select Remove. This will cause a compilation error.

|||t 3 |E
Ei;_'j example_project [C]

£ Source

Elﬁ sources

| examplec

E}@ Include

xj Remove Delete

= Log”
= Project Properties Alt+P

2 On the Project Manager toolbar, click b Run

The software compiles your code and checks for errors, and reports the
results on the Output Summary tab.
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1 Preprocessing Errors: 2

. File ... Message Suggestion/Remark Action
example.c 1 |could not open source file "math.h”™ Add indude folder for: math.h - Ad
example.c 2 |could not open source file “indude.h™ Add indude folder for: indude.h = Ad

@ Full Log | i Verification Statistics | Progress Monitor Cutput Summary

Because you removed the include folder, the software reports a compilation
error for the project, along with suggested solutions for the problem.

3 Select a Suggestion/Remark cell to see a list of possible solutions for
the problem.

-g Output Summary - [C:\Users\srunstro\AppDataiLocal\TempPolyspace 1308548328550\ CompileAssistant] O &
@ Preprocessing Errors: 2 | [] Filter warnings {0)

Type File Line Message SuggestionRemark Action
could not open source file "math.h™  |Add indude folder for: math.h -

example.c 2 could not open source file “indude.h™ #.dd include folder for: indude.h
Add indude folder for: indude.h

Set option: -ignore-missing-headers *

In this case, you can either add the missing include file, or set an option
that will attempt to compile the code without the missing include file.

4 Select Set option: -ignore-missing-headers. Then click Apply.

5 The software automatically sets the option Ignore missing header files
for your project. You can see this new option in the Assistant Active
Settings table on the Configuration > Compiler Settings tab.
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Active Settings

X

Description Option
Ignore assembly code -discard-asm
Allow negative operand for left shifts | -allow-negative-operand-in-shift
Accept integral type conflicts -permissive-ink

Allow language extensions -gllow-language-extensions
Allow non int types for bitfields -gllow-non-int-bitfield

Allow anonymous unions/structure fields|-allow-unnamed-fields
Code from DOS or Windows filesystem  |-dos

Allow undefined global variables -gllow-undef-variables

6 On the Project Manager toolbar, click P Run .

You see compilation warnings, since the code cannot be compiled without
include.h.

7 In the Project Browser tree, right-click the Include folder. From the
context menu, select Add, then click Add.

The Add Source Files and Include Folders dialog box opens.
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-~ Polyspace Project - Add Source Files and Include Folders

Lookin: |

L
=
Recent Items

Desktop

¥
My Documents

i ..
[

Computer

@

Network

. palyspace_project M ;4 *:EI 7] Add recursively| i | + ¥
. includes EH_) example_project [C]
| Sources E}Lj' Source

| EE3 sources

._. example.c

B3 Indude

-{£3 C:\Polyspace\polyspace _projectincludes
File name: | | Add Source

Files of type: .{‘.c) files only

| Add Indude

8 If necessary, navigate to the polyspace_project folder.

9 Select the includes folder. Then click Add Include.

The includes folder appears in the Include tree for example project.

10 Click Finish.

11 On the Project Manager toolbar, clic

The verification runs successfully.

K P}'Run'
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Starting Server Verification from Project Manager

In this section...

“Starting the Verification” on page 3-10
“Monitoring Progress of the Verification” on page 3-12
“Removing Verification Results from the Server” on page 3-18

“Troubleshooting a Failed Verification” on page 3-19

Starting the Verification

In this part of the tutorial, you run the verification on a server.
To start a verification that runs on a server:

1 In the Project Manager perspective, on the Configuration > All Settings
tab, select the General > Send to Polyspace Server check box.

Analysis options

[=]-General
----- Add to results repository 0 -add-to-resultsrepository
----- Keep all preliminary results files 0 +keep-all-files
----- Calculate code metrics 0 -code-metrics
[=-Report Generation ]
“-Report template name Developer -report-template
-Qutput format RTF —report-output-format

H-Target/Compilation

H-Compliance with standards

H-Predsion Scaling
H-Multitasking

[
[#
[#-Polyspace inner settings
E
E

2 On the Project Manager toolbar, click P Run .

Note If you see the message Verification process failed, click OK
and go to “Troubleshooting a Failed Verification” on page 3-19.

The verification has three main phases:
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Checking syntax and semantics (the compile phase). Because Polyspace
software is independent of any particular C compiler, it ensures that
your code is portable, maintainable, and complies with ANSI® standards.

Generating a main if the Polyspace software does not find a main and
you have selected the Generate a Main option. For more information
about generating a main, see “Main Generator Behavior for Polyspace
Software” in the Polyspace Products for C/C++ Reference.

Analyzing the code for run-time errors and generating color-coded
results.

The compile phase of the verification runs on the client. When the compile
phase is complete:

You see the message queued on server at the bottom of the Project
Manager perspective. This message indicates that the part of the
verification that takes place on the client is complete. The rest of the
verification runs on the server.

A message in Qutput Summary gives you the identification number
(Analysis ID) for the verification. For this verification, the identification
number is 1.

'Z,utpuit Summary - [C: PolySpace polyspace proectVerificaton_iResult ] 88X

Search: 4

2

Class

Description

example_project for C verification start at Dec 15, 2010 15:57:15

File Line Cal

»

[The generated default DRS XML file “drs-template.xml” can be found in <result_dir. .. [

AnalysisID : 1

3 For information on any message in the log, click the message.
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Monitoring Progress of the Verification

There are two ways to monitor the progress of a verification:

¢ Using the Project Manager — Allows you to follow the progress of the
verifications you submitted to the server, as well as client verifications.

¢ Using the Queue Manager (Spooler) — Allows you to follow the
progress of any verification job in the server queue.

Monitoring Progress Using Project Manager

You can monitor the progress of your verification by viewing the progress
monitor and logs at the bottom of the Project Manager perspective.

4

Intermediate: 100%:
00:00:03

Verification is running on server with ID: 1

LevelD: 100% Levell: 83% Level2 : 0% I Level3d : 0%
00:00:20 00:00:13 00:00:00 00:00:00

1 [ F

The progress monitor highlights the current phase in blue and displays the
amount of time and completion percentage for that phase.

The logs report additional information about the progress of the verification.
To view a log, click the button for that log. The information appears in the
log display area at the bottom of the Project Manager window. Follow the
next steps to view the logs:

1 Click the Output Summary tab to display compile phase messages and
errors. You can search the log by entering search terms in the Search in
the log box and clicking the left arrows to search backward or the right
arrows to search forward.

2 Click the Verification Statistics tab to display statistics, such as analysis
options, stubbed functions, and the verification checks performed.
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3 Click the Refresh button
progresses.

to update the display as the verification

4 Click the Full Log tab to display messages, errors, and statistics for all
phases of the verification.

Note You can search the logs. In the Search in the log box, enter a
search term and click the left arrows to search backward or the right
arrows to search forward.

Monitoring Progress Using Queue Manager

You monitor the progress of the verification using the Polyspace Queue
Manager (also called the Spooler).

To monitor the verification of Example Project:

1 Double-click the Polyspace Spooler icon on the desktop.

The Polyspace Queue Manager Interface opens.

Polyspace Queue Manager Interface E\

Operations Help

D Author Application Results folder CPU Status Date Language
(23 |username |example_project |C:\PolySpace\polyspace_project!Verification_1\Result_9 |AH-SRUNS... [completed [15-Dec-2010, 16:0%:33 [c

= o 0 0 o catio 0 A g O 010, 16:0

------ 25 |username |example_project |C:\PolySpace\polyspace _project\verification_1\Result_11 gueued  |15-Dec-2010, 16:03:21 |C

Connected to Queue Manager AH-SRUNSTRO.dhcp.mathworks.com User mode
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Tip You can also open the Polyspace Queue Manager Interface by

clicking the Polyspace Queue Manager icon E on the Run-Time Checks
perspective toolbar.

2 Point anywhere in the row for ID 1.

3 Right-click to open the context menu for this verification.
Follow Progress...
View Log File...
Download Results...

Download Results in Mew Polyspace Window...

Download Results and Remove From Queue...
Move Down in Queue

Stop...
Stop and Download Results...

Stop and Remowe From Queue...

Remowve From Queue...

4 Select View log file.

A window opens displaying the last one-hundred lines of the verification.
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[ view Log File (23]

Generating results in a spreadsheet format in C:\FolySpace\FolySpace_ “

Generation complete

v o o o o o o o o o o o ol o ol o o o o ol ol ol ol ol ol oy o oy ol ol o o oy o oy ol o o ol o o e o o o o o o ol o o o ol o o ol o o
L

#%% Spoftware Safety Analysis Level 4 done

L

v o o o o o o o o o o o ol o ol o o o o ol ol ol ol ol ol oy o oy ol ol o o oy o oy ol o o ol o o e o o o o o o ol o o o ol o o ol o o
Ending at: Dec 15, 2010 16:4:26

User time for pass4: 00:00:02.34 (2.3real, 2.3u + 0s)

Generating remote file
Done
User time for polyspace-c: 00:00:49.27 (49.3real, 49.3u + 0s (0.1lgc))

"R

#*#% EFnd of Polyspace Verifier analysis
LA i
4| 1 §

Cloze

1 [

5 Click Close to close the window.
6 Select Follow Progress from the context menu.

The Progress Monitor opens.
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ace for
File Edit Window
Progress Monitor

Intermediate: 100%

00:00:03

Help

Leveld: 100% Levell: 100% Level2: 100% Level3: 0% |' Level4 : 0% || Total
00:00: 21 00:00:14 00:00:03 00:00:01 00:00:00 00:00:41

"% Verification Statistics

I}
L=

Number of files
Number of lines

Number of lines without comments @ 136

i1

12498

Lm] »

Automatically stubbed pure functions :

random_int
random_float
get_bus_status

Stats on aliases :

Some stats on aliases computation:

Mumber of invisibles:
Mumber of alias reads:
Mumber of pma writes:

i
0
5

1 | »

l
@ Full Log h Verification Statistics Output Summary |

You can monitor the progress of the verification by watching the progress
bar and viewing the logs at the bottom of the window. The progress monitor
highlights the current phase in blue and displays the amount of time and
completion percentage for that phase.

The logs report additional information about the progress of the verification.
To view a log, click the button for that log. The information appears in the
log display area at the bottom of the Project Manager window. Follow the
next steps to view the logs:
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e (Click the Output Summary tab to display compile phase messages and
errors. You can search the log by entering search terms in the Search
in the log box and clicking the left arrows to search backward or the
right arrows to search forward.

e (Click the Verification Statistics tab to display statistics, such
as analysis options, stubbed functions, and the verification checks
performed.

¢ (Click the Refresh button
progresses.

to update the display as the verification

¢ (Click the Full Log tab to display messages, errors, and statistics for all
phases of the verification.

Note You can search the logs. In the Search in the log box, enter a
search term and click the left arrows to search backward or the right
arrows to search forward.

7 Select File > Quit to close the progress window.
8 Wait for the verification to finish.

When the verification is complete, the status in the Polyspace Queue
Manager Interface changes from running to completed.

Peolyspace Queue Manager Interface E\@

Operations Help

D Author

+-23 |username

25 |username

Application Results folder CPU Status Date Language
example_project (C:\PolySpace'\polyspace_projectierification_1\Result_9  |[AH-SRUNS... [completed |15-Dec-2010, 16:03:33 |C

g o 0 = O = o catio 0 A 0 d { 010, 15:04

example_project (C:\PolySpace\polyspace_projectiverification_1\Result_11 [AH-SRUNS... [completed |15-Dec-2010, 16:05:13 |C

Connected to Queue Manager AH-SRUNSTRO.dhcp.mathworks.com User mode
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Removing Verification Results from the Server

At the end of a server verification, the server automatically downloads
verification results to the results folder specified in the project. You do not
need to manually download your results.

Note You can manually download verification results to another location on
your client system, or to other client systems.

Verification results remain on the server until you remove them. Once your
results have been downloaded to the client, you can remove them from the
server queue.

To remove your results from the server:

1 In the Polyspace Queue Manager Interface, right-click the verification,
and select Remove From Queue.

A dialog box opens to confirm that you want to remove the verification
from the queue.

Remowve From Queue @

'jO:' Do you really want te remove the selected verification(s) from the queue?

Yes | | MNo

2 Click Yes.

Note To download the results and remove the verification from the queue,
right-click the verification and select Download Results And Remove
From Queue. If you download results before the verification is complete,
you get partial results and the verification continues.

3 Select Operations > Exit to close the Polyspace Queue Manager Interface.
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Once the results are on your client, you can review them using the Run-Time
Checks perspective. You review results from the verification in Chapter 4,
“Reviewing Verification Results”.

Troubleshooting a Failed Verification

When you see a message that the verification failed, it indicates that
Polyspace software could not perform the verification. The following sections
present some possible reasons for a failed verification.

Hardware Does Not Meet Requirements

If your computer does not have the minimum hardware requirements. the
verification fails. For information about the hardware requirements, go to:

www.mathworks.com/products/polyspaceclientc/requirements.html.

To determine if this is the cause of the failed verification, search the log for
the message:

Errors found when verifying host configuration.
You can:

e Upgrade your computer to meet the minimal requirements.

¢ In the General section of the Analysis options, select the Continue with
current configuration option and run the verification again.

You Did Not Specify the Location of Include Files

If you see a message in the log, such as the following, either the files are
missing or you did not specify the location of include files.

include.h: No such file or folder

For information on how to specify the location of include files, see “Creating a
New Project to Verify the Example C File” on page 2-7.
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Polyspace Software Cannot Find the Server
If you see the following message in the log, Polyspace software cannot find
the server.

Error: Unknown host

Polyspace software uses information in the preferences to locate the server.
To find the server information in the preferences:

1 Select Options > Preferences.

2 Select the Server Configuration tab.



Starting Server Verification from Project Manager

=+ Polyspace Preferences IEI
| Tools Menu | Review statuses | Aggistant configuration | Mizcellaneous | Character encoding
Server configuration | Results folder | Editors | Generic targets

Remote configuration

Mote: Send to Polyspace server option is mandatory when the project contains multitasking options.
The multitasking options will be ignored otherwize.

@ Automatically detect the remote server

(7 Use the following server and port: [ -0 12427

The server name Tocalhost”™ can be used if the server is the local machine.
Metrics configuration

Polyspace Metrics allows you, through a web browser, to drill down to specific coding rule violations and run-time checks. If you
want to view or dassify these items as defects within Polyspace, you dick the item. Polyspace opens with the spedfic item
displayed. However, this requires the downloading of result files from the Polyspace Metrics web interface to a locally accessible
folder. On this tab, you specify how result files are downloaded from the Polyspace Metrics web interface and when justifications
are saved in the Polyspace Metrics database.

If you select this check box, results are downloaded to the folder where the verification was launched. If this launch folder does
not exist, results are downloaded to the location spedified in the Folder field.
Otherwise, a file browser allows you to select the download location.

Download results automatically
Folder: Vinfrnas-00-ah'srunstro\Documents\Polyspace_Workspace\DownloadedResults

If you select this check box, the save action (Ctrl+5) will save your justifications in the local results folder and the Polyspace
Metrics database. If you do not select this chedk box, the save action will save justifications in the local results folder only. If you
want to save justifications in the Polyspace Metrics database, dick the 'Save in database' button.

Save justifications in the Polyspace Metrics database

Port used to communicate with the Polyspace Metrics web interface.

Port number: 12428

The Polyspace Metrics web interface URL is defined as follow: http://<remoteServer >; <porthumber >,
The remote server can be configured above.

Web server port number: 8080

’ oK ]| Apply |[ Cancel

By default, Polyspace software automatically finds the server. You can
specify the server by selecting Use the following server and port and
providing the server name and port. For information about setting up a
server, see the Polyspace Installation Guide.

3-21



3 Running a Verification

Using Polyspace In One Click to Launch Verification

In this section...

“Overview of Polyspace In One Click” on page 3-22
“Setting the Active Project” on page 3-22

“Sending Files to Polyspace Software” on page 3-24

Overview of Polyspace In One Click

In a Microsoft Windows environment, Polyspace software provides a
convenient way to streamline your work when you want to verify several
files using the same set of options. Once you have set up a project file that
has the options that you want, you designate that project as the active project,
and then send the source files to Polyspace software for verification. You do
not have to update the project with source file information. This process is
called Polyspace In One Click.

In this part of the tutorial, using Polyspace In One Click, you learn how to:

1 Set the active project.

2 Send files to Polyspace software for verification.

Setting the Active Project

The active project is the project that Polyspace In One Click uses to verify the
files that you select. Once you have set an active project, it remains active
until you change the active project. Polyspace software uses the analysis
options from the project; it does not use the source files or results folder from

the project.
To set the active project:

1 In the taskbar area of your Windows desktop, right-click the Polyspace In
One Click icon:

The context menu appears.
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Set active project v

Palyspace - Project Manager
Polyspace - Results Manager
Spooler

Help »

Exit

2 Select Set active project > Browse. The Open Polyspace Project dialog
box opens.

3 Navigate to polyspace_project.

4 Select example project.cfg.

1 Ppen Polyspace Project
Lookini | |. polyspace_project =
T . includes
&} . Module 1
Recent Items . SOUTCes
Bl eample_project.cig
Desktop
£
My Documents
LY
Computer

=
h File name: example_project.cfg
Netork  Fies of type: Project file (%.cfg) .

5 Click Open.
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Sending Files to Polyspace Software

You can send several files to Polyspace software for verification. For this
tutorial, you send one file, example.c.

To send example.c to Polyspace software for verification:

1 Navigate to the folder polyspace_project\sources.
2 Right-click the file example.c.

The context menu appears.

Name

El evamnls -
Open
Edit

L Scanfor viruses

Open with 4
G WinZip 3
Restore previous versions
& Adobe Drive C54 >
Send to 3
Cut
Copy

Create shortcut
Delete

Rename

Properties

3 Select Send To > Polyspace.
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Open
Edit

P Scanforviruses

Open with 2
& WinZip 2
Restore previous versions
= Adobe Drive C4 3
Send to » Bluetooth
Cut |, Compressed (zipped) folder
Copy F Desktop (create shortcut)
5| Documents
Create shortcut G5 Fax recipient
BiElete ) Mail recipient
Rename E Polyspace
Properties < DVD RW Drive (D:

The Polyspace Language Selection dialog box opens.
4 Select Polyspace for C/C++.

5 If the results folder has previous results, you see a dialog box.
Polyspace @
! _ Allfiles found in C:\Polyspace\polyspace_project\Module 1%Result 3 will be removed.

The following will be deleted:
- All Polyspace results.
- All user review information (Ceding Rules and Run-Time Errors).
- Medifications to the data range specifications file (drs-working-copy.axml).

De you wish to choose another result folder?

| Yes | | No | | Cancel

6 Click either Yes or No.

If you click Yes, the Choose a Result Folder dialog box opens. Use this
dialog box to navigate to, and select the required results folder.

The verification starts and, after the following message, runs “silently” to
completion.
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Polyspace

=)

lol Verification was started in the following folder: C:\Polyspace\polyspace_project\Module_1\Result_3

To view results:

1 Right-click the Polyspace In One Click icon .
2 From the context menu, select Polyspace - Project Manager.

3 From the Polyspace Language Selection dialog box, select Polyspace for

C/C++. The Project Manager perspective of the Polyspace verification
environment opens.

4 In the Project Browser pane, from the results folder, double-click the
results file, for example, RTE_px_example project LAST RESULTS.rte.
The Results Manager perspective opens displaying the verification results.
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Launching Client Verification from Project Manager

In this section...

“Starting the Verification” on page 3-27
“Monitoring the Progress of the Verification” on page 3-29
“Completing Verification” on page 3-30

“Stopping the Verification Before It is Complete” on page 3-31

Starting the Verification

For the best performance, run verifications on a server. If the server is busy
or you want to verify a small file, you can run a verification on a client.

Note Because a verification on a client can process only a limited number
of variable assignments and function calls, the source code should have no
more than 800 lines of code.

To start a verification that runs on a client:

1 If the project example_project.cfg is not already open, open the project.

For information about opening a project, see “Preparing for Verification”
on page 3-4.

2 In the Project Manager perspective, on the Configuration > All Settings
tab, clear the General > Send to Polyspace Server check box.
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Analysis options
[=]-General
----- Add to results repository 0 -add-to-resultsrepository
----- Keep all preliminary results files 0 +keep-all-files
----- Calculate code metrics 0 -code-metrics
[=-Report Generation ]
“-Report template name Developer -report-template
-Qutput format RTF —report-output-format
[#-Target/Compilation
[#-Compliance with standards
[#-Polyspace inner settings
[+-Predsion/Scaling
[#-Multitasking

3 On the Project Manager toolbar, click |m|.

4 If you see a caution that Polyspace software will remove existing results
from the results folder, click Yes to continue and close the message dialog
box.

The Output Summary and Progress Monitor windows become active,
allowing you to monitor the progress of the verification.

Note If you see the message Verification process failed, click OK
and go to “Troubleshooting a Failed Verification” on page 3-19.
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Monitoring the Progress of the Verification

You can monitor the progress of the verification by viewing the progress
monitor and logs at the bottom of the Project Manager perspective.

4

Intermediate: 100%:
00:00:03

Verification is running on server with ID; 1

Leveld: 100%: Levell: 89% Level2 : 0% I Level3 : 0%
00:00:20 00:00:13 00:00:00 00:00:00

T | 3

The progress monitor highlights the current phase in blue and displays the
amount of time and completion percentage for that phase.

The logs report additional information about the progress of the verification.
To view a log, click the button for that log. The information appears in the
log display area at the bottom of the Project Manager window. Follow the
next steps to view the logs:

1 Click the Output Summary tab to display compile phase messages and
errors. You can search the log by entering search terms in the Search in
the log box and clicking the left arrows to search backward or the right
arrows to search forward.

2 Click the Verification Statistics tab to display statistics, such as analysis
options, stubbed functions, and the verification checks performed.

3 Click the Refresh button _*
progresses.

i1to update the display as the verification

4 Click the Full Log tab to display messages, errors, and statistics for all
phases of the verification.
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Note You can search the logs. In the Search field, enter a search term
and click the left arrows to search backward or the right arrows to search
forward.

Completing Verification

When the verification is complete, the message End of Polyspace Verifier
analysis appears in Full Log, and the results file appears in the Project
Browser pane.

-I£3|[ﬁ‘l| ER A=

E 1._‘;1 example_project [C]
E} IE'..' Source
B ’E‘ SOUrces
: s | example.c
E‘ Include
----- = "uncludes
B &
EI E‘ Source
B E‘ SOUrCes
- || example.c
El E‘ Configuration
124 example_project
=8 3 Result
EFE' Result_2 [Verification Completed]
{E options

------ RTE_px_example_project LAST_RESULTSate

In the tutorial Chapter 4, “Reviewing Verification Results”, you open the
Results Manager perspective and review the verification results.
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Stopping the Verification Before It is Complete

You can stop the verification before it is complete. If you stop the verification,
results are incomplete. If you start another verification, the verification starts

from the beginning.

To stop a verification:

1 On the Project Manager toolbar, click the Stop button O STDF

A warning dialog box opens.

-

Polyspace Verification Warning @

! . Do you really want to stop the current execution?
L1

| Yes | | Mo ‘

2 Click Yes. The verification stops.

3 Click OK to close the Message dialog box.

Note Closing the Polyspace verification environment window does not stop
the verification. To resume display of the verification progress, start the
Polyspace software and open the project.
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Reviewing Verification
Results

* “About Reviewing Verification Results Tutorial” on page 4-2
® “Opening Verification Results” on page 4-3

e “Exploring Results Manager perspective” on page 4-4

* “Reviewing Results” on page 4-8

® “Reviewing Results Systematically” on page 4-24

e “Automatically Testing Unproven Code” on page 4-30

® “Generating Reports of Verification Results” on page 4-31



4 Reviewing Verification Results

4-2

About Reviewing Verification Results Tutorial

In this section...

“Overview” on page 4-2

“Before You Start” on page 4-2

Overview

In the previous tutorial, Chapter 3, “Running a Verification” , you completed a
verification of example.c. In this tutorial, you explore the verification results.

The Polyspace verification environment contains a Results Manager
perspective, which you use to review results. In this tutorial, you learn:
1 How to use the Results Manager perspective, including how to:
¢ Open the Results Manager perspective and view verification results.
® Review results

® Generate reports.

2 How to interpret the color-coding that Polyspace software uses to identify
the severity of an error.

3 How to find the location of an error in the source code.

Before You Start

Before starting this tutorial, be sure to complete the tutorial Chapter 3,
“Running a Verification”.

In this tutorial, you use the verification results in this file:

polyspace_project\Verification_(1)\Result_(1)\
RTE_px_example_project LAST_RESULTS.rte.
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Opening Verification Results

In this section...

“Opening Results Manager perspective” on page 4-3

“Opening Verification Results” on page 4-3

Opening Results Manager perspective

Use the Results Manager perspective to review verification results.
To open the Results Manager perspective:

¢ In the Polyspace verification environment toolbar, select the Results

Manager button ';L e ——— .

Opening Verification Results
To open the verification results:

1 In the Polyspace verification environment, select File > Open Result.
The Open results dialog box opens.

2 Navigate to the results folder:
polyspace_project\Module_ (1)\Result (1).

3 Select the file RTE_px_example project LAST RESULTS.rte.

4 Click Open. The results appear in the Results Manager perspective.

Note You can also open results from the Project Manager perspective by
double-clicking the results file in the Project Browser.
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Exploring Results Manager perspective

In this section...

“Overview” on page 4-4

“Reviewing the Results Explorer Tab” on page 4-5

Overview
The Results Manager perspective looks like the following figure.

Check details

Review statistics and
check information

File Edit Run Review Options Window Help
‘E‘@@H|'ﬁ @|J§%D§‘% eu|@.‘|553rd1:‘ v|,®E|CsesenmnveE|mmemdv |8PmJectMan>qerI-9-Resﬂtster
Hi “_‘] 7 3 i Methodology for G I L A T
All chedks B ‘ k.TYE :57 ..Y 517 E.Y 5.7 ﬁ' ﬂﬁ TE "Ew example.c / Pointer_Arithmetic| 1 ops
i 1
Procedural entities ¥ | |Llne C 104 #*p = 5; /* Qut of bounds */
|# Demo_G (unp: 1/44, cov: 85%) 0 |25 _* 1 |[1oP.8 Error : pointer is outside its bounds | —
E-exam = |3 lsa| 1 dereference of local variable 'p' (pointer to int 32, size: 32 bits): patus
N . ol zr painter is not null 8 =
- . paints to 4 bytes at offset 400 in buffer of 400 bytes, so is outside bounds i
-Non_Infinite_Loop () 11| @8 may point to variable or field of variable in: {Painter_Arithmetic:array} [ Justified
=h-Pointer_Arithmetic { } 1] 3|19 89 Enter comment here...
~F NIVL.O 1| 84 L
W NIV 1] 84 B Review Statistics | ¥ Check Review
wnd OVFL2 1 M|l e S - -
rart
~~F IDP.3 1| o8
example.c
o NIP.4 1| s8 =
~ NP5 1 a7 L4 Calls
ag '
~F MISRAC 174 1 97 a0 ~
- IRV.G 1| 100 ¥ pst_stubs_0.get_bus_ststus B
P i 100 if (get_bus_status() > 0) b example get oil_pressurs
- 1 104 - ! - b pst_stubs_0.get_bus_status -
-t 10z if{get 0il pressure() » 0} 44 T N
~~# NP9 1| 104 103 '
T
R UNR-10 ! o7 104 Fp = 5; /7 Out of bounds */ —
¥ RV13 1| 112 108 ¥ e 3
- NIVL14 1| 14 106 else —
ol NP1 1| 114 107 I peroc [
o NVLAT 1] 114 108 it -
~% MISRAC 174 1 114 | 7| 109 3 [-initislisstions.cument_data
< n J 110 1 El-initi first_pailosd -
| 2 Results Explorer | -2 Results Summary | 111 hd | K [P »
| % | Function returns an initialized value ~ Col: 5

Run-time checks and
coding rule violations

Source code

Variable access

Call hierarchy



Exploring Results Manager perspective

The Results Manager perspective has six sections below the toolbar. Each
section provides a different view of the results. The following table describes

these views.

This Pane or Tab ...

Displays ...

Results Explorer\Results Summary
(Procedural entities view)

List of the checks (diagnostics) for
each file and function in the project

Source Source code for a selected check in
(Source code view) the procedural entities view
Check Details Details about the selected check

(Selected check view)

Check Review\Review Statistics
(Coding review progress view)

Review information about the
selected checkStatistics about the
review progress for checks with
the same type and category as the
selected check

Variable Access
(Variables view )

Information about global variables
declared in the source code

Call Hierarchy
(Call tree view)

Tree structure of function calls

You can resize or hide any of these sections. You learn more about the Results
Manager perspective later in this tutorial.

Reviewing the Results Explorer Tab

The Results Explorer tab displays a table with information about the
diagnostics for each file in the project. The Results Explorer tab is also

called the Procedural entities view

When you first open the results file from the verification of example.c, you

see the following procedural entities.
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All checks | ¥ % %%y
Procedural entities §|X| #|v|¥|Lne col =|Detais
3|z 175]| 85 24
xample.c 3|2 42 | 83 A 84 lexample.c
nclude.h 18 0 |include.h
nath.h 115 0 |math.h
_polyspace__stdstubs.c 1 0 | polyspace__stdstubs.c
_polyspace_main.c 2 A 100 _pelyspace_main.c
1| 1 F

. Results Explorer

S Results Summary

The file example.c is red because it has a run-time error. Polyspace software

assigns each

file the color of the most severe error found in that file. The first

column of the table in the Procedural Entities view is the procedural entity
(the file or function). The following table describes some of the other columns
in the procedural entities view.

Column
Heading

Indicates

]

Number of red checks (operations where an error always
occurs)

x|

Number of gray checks (unreachable code)

Number of orange checks (warnings for operations where
an error might occur)

Number of purple checks (coding rule violations)




Exploring Results Manager perspective

Column Indicates

Heading

ﬂ Number of green checks (operations where an error never
occurs)

ﬂ Selectivity of the verification (percentage of checks that are
not orange)
This is an indication of the level of proof.

Note You can select which columns appear in the procedural entities view
by editing the preferences.

What you select in the procedural entities view determines what you see in
the other views. In the following examples, you learn how to use the views
and how they interact.
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Reviewing Results

In this section...

“What are Review Levels?” on page 4-8

“Displaying All Checks” on page 4-9

“Reviewing All Checks” on page 4-9

“Reviewing Additional Examples of Checks” on page 4-15
“Filtering Checks” on page 4-20

What are Review Levels?

To facilitate your review of verification results, Polyspace allows you to specify
the type of results displayed in the Procedural entities and Source views
of the Results Manager perspective. You can specify:

® Type of coding rule violations, that is, purple checks

¢ Type and number of orange run-time checks
There are five levels at which you can review your results:

® 0 — The software displays violations of coding rules with state Error and
red and gray run-time checks. You can configure the software to displays
orange checks that are potential run-time errors. Through the Polyspace
Preferences > Review Configuration tab, specify the categories of
potential run-time errors that you want the software to display. By
default, the software does not display any orange checks at this level. See
“Reviewing Checks at Level 0” on page 4-24.

This level i1s suitable for the review of fresh code.

e 1, 2, and 3 — The software displays all purple checks and red, gray,
and green run-time checks. The software displays orange checks
according to values specified on the Polyspace Preferences > Review
Configuration. You can use either a predefined methodology or a custom
methodology to specify the number of orange checks per check category.
See “Reviewing Checks at Levels 1, 2, and 3” on page 4-25.
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For a predefined methodology, these levels are suitable for reviews at the
following stages of the development process.

Level Development Stage
1 Fresh code

2 Unit tested code

3 Code Review

e All — The software displays all purple checks and red, gray, green, and
orange checks. When you want to carry out an exhaustive review of your
verification results, use this level. See “Reviewing All Checks” on page 4-9.

The toolbar in the Results Manager perspective provides controls specific
to review levels.

T o [Methodology forc -~ % 4 p M

A
L

The controls include:

¢ A slider for selecting the review level — 0, 1, 2, 3, or A1l1l. By default, the
Results Manager perspective opens at level 1.

¢ A menu for selecting the review methodology for levels 1, 2, and 3.

* Arrows for navigating through checks.

Displaying All Checks

By default, the Results Manager perspective opens at level 1. To display all
checks in the Procedural entities view, move the Review Level slider to A11.

Reviewing All Checks

In this part of the tutorial, you learn how to use the Results Manager
perspective to examine verification checks. This part of the tutorial covers:

e “Selecting a Check to Review” on page 4-10
¢ “Displaying the Calling Sequence” on page 4-12

e “Tracking Review Progress” on page 4-12
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Selecting a Check to Review

In the procedural entities view, example.c is red, indicating that this file has
at least one red check. To review a red check in example.c:

1 In the procedural entities section of the Results Explorer tab, expand

example.c.

2 Expand the red procedure Pointer Arithmetic().

A color-coded list of the checks performed on Pointer_ Arithmetic() opens.

[-Painter_Arithmetic { )
----- ~F NIVL.5
----- ' NIVL3
..... @ OVFL.4

89
94
54
94

=] [ Ry
DCI XX

@

95

example.c
Local varisble is initislized {type: int 32)

Local variable is initialized {type: int 32)

Operation [+] on scalar does not overflow in INT22 range

FPointer is within its bounds

Fointer is initialized

Paointer is initialized

Error : pointer is outside its bounds
Fointer is initialized

Unreachable code

Local varisble is initislized {type: int 32)
Warning : pointer may be outside its bounds
Pointer is initialized

Local varisble is initislized {type: int 32)
Local variable is initialized {type: int 22)
Local variable is initialized {type: int 32)
Fointer is initialized

Local variable is initialized {type: int 22)

Pointer is within its bounds

Pointer is initialized

In the list of checks, each item has an acronym and a number. The acronym
identifies the check type. For example, in IDP.9, IDP stands for Illegal
Dereferenced Pointer. For more information, see “Check Descriptions for C
Code” in the Polyspace Products for C/C++ Reference.

3 Click the red IDP.9.

The Source pane displays the section of source code where this error

occurs.
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Example.c| 14 &

9z int i, *p = array:

93

04 for(i = 0; 1 £ 100; i+H]

a5 {

95 o= 0;

a7 P+

95 3

a9

100 if(get_bus_status() > 0]

10l {

102 if(get o0il pressure() > 0)

103 {

104 po= 5: /% Out of boundsz */
105 3

106 else

107 {

105 14+

109 1

110 3 r
' i | b

[

4 At line 104 of the code, click the red code.

An error message box opens indicating that when the pointer p is
dereferenced, it is outside of its bounds. At line 92, p points to the start of
array which has 100 elements. The for loop starting at line 94 initializes
the elements of array to 0. This for loop leaves p pointing to the location
after the last element of array
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Displaying the Calling Sequence

You can display the calling sequence that leads to the code associated

with a check. To see the calling sequence for the red IDP.9 check in
Pointer_Arithmetic():

1 Expand Pointer_Arithmetic().

2 Click the red IDP.9.

E
3 Click the call graph button ii‘ in the Check Review toolbar.

A window displays the call graph.

_

@ '[:_|' 95% - U iy

Demo_C - Acce...is.c output_v7 | Demo_C - Call...ithmetic.IDP.9 4 B
main.c example.c example.c example.c
main RTE Pointer_Arithmetic IoP.9

The code associated with IDP.9 is in Pointer_Arithmetic. The generated
main function calls RTE, which calls Pointer_Arithmetic.

Tracking Review Progress

You can keep track of the checks that you have reviewed by marking them. To
mark that you have reviewed the red IDP.9 check in Pointer_Arithmetic():

1 Expand Pointer_Arithmetic().

2 Click the red IDP.9.

The Review Statistics tab displays a table with statistics about the
review progress for that category and severity of error.
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Coding review progress Count Progr...
Red IDP justified / to justify 0/1 0
Red justified / to justify 08 0
Gray justified [ to justify 0/e 0
Crange justified / to justify 0,20 0
Software reliability indicator 215/249 36

The Count column displays a ratio and the Progress column displays
the equivalent percentage.

The first row displays the ratio of justified checks to total checks that have
the same color and category as the current check. In this example, the
first row displays the ratio of reviewed red IDP checks to total red IDP
errors in the project.

The second row displays the ratio of justified checks to total checks that
have the same color as the current check. In this example, this ratio is the
ratio of red errors reviewed to total red errors in the project.

The last row displays the ratio of the number of green checks to the total
number of checks, providing an indicator of the reliability of the software.

Information about the current check (the red IDP.9) appears in the Check
Details pane (selected check view).

{5' ﬂﬁ 4= "F" example.c / Pointer_Arithmetic

104 *p = 5; /* Qut of bounds */

IDP.8 Error : pointer is outside its bounds
dereference of local variable 'p' (pointer to int 32, size: 32 bits):
pointer is not null
points to 4 bytes at offset 400 in buffer of 400 bytes, so is outside bounds
may point to variable or field of variable in: {Pointer_Arithmetic:array}

3 After you review the check, from the Check Review tab, select a
Classification to describe the severity of the issue:

® High

e Medium
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® [ow

® Not a defect

4 From the Check Review tab, select a Status to describe how you intend
to address the issue:

® Fix

* Improve

® Investigate

® Justify with annotations

® No Action Planned

® Other

® Restart with different options

® Undecided

Note You can also define your own statuses. See “Defining Custom Status

”»

5 On the Check Review tab, in the comment box, enter additional
information about the check.

6 Select the check box to indicate that you have justified this check.

The Coding review progress part of the window updates the ratios of
errors reviewed to total errors.

_

Coding review progress Count Progress
Red IDP justified / to justify 11 100
Red justified [ to justify 1/8 12|
Gray justified [ to justify 06 0
Crange justified [ to justify 0,20 [u}
Software reliability indicator 215/249 86
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Reviewing Additional Examples of Checks

In this part of the tutorial, you learn about other types and categories of
errors by reviewing the following examples in example.c:

e “Example: Unreachable Code” on page 4-16

e “Example: Arithmetic Error” on page 4-17

e “Example: A Function with No Errors” on page 4-18

e “Example: Division by Zero” on page 4-18
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Example: Unreachable Code

Unreachable code is code that never executes. Polyspace software displays
unreachable code in gray. In the following example, you look at an example
of unreachable code.

1 In Procedural Entities, click Unreachable Code().

The source code view displays the source code for this function.

example.c 4 B
196 -
197

195

199 static void Unreachable Code(woid)

200 /% Here we demonstrate Polyspace Werifier's ability to

201 identify unreachahle sections of code due to the

202 walue constraints placed on the wariables.

Z03 i

z04 ! int ¥ = randon int();

Z05 int ¥ = randon int():

Z06

207 if (x> ¥

208 {

203 X o= H - ¥

210 if iz < 0 £l
z11 1

zlz ¥ =x+ 1;

213 1 -
1 | 1 "

2 Examine the source code.

At line 210, the condition x < 0 is always false. The curly bracket { is gray
because the branch is never executed.
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Example: Arithmetic Error
In the following example, Polyspace software detects a memory corruption
error:

1 In the Procedural entities view, expand the red Square_Root () function.

The source code view displays the source code for this function.

(“sowce - ORX

Example.c| 4 F B
-

179 static void Jgquare Foot conv (double alpha, float *heta pt)

180 % Perform arithmetic cohverzion of alpha to beta +/

18l {

laz heta pt = (float)({1.5 + cos{alpha))/5.0);

1a83 1

154

155 gtatic woid 3quare Root (woid)

186 !

157 double alpha = randow float(]);

1588 float bhetar

153 float gamma; |

190 E

191 druare Root_conw (alpha, sbheta);

192

193 gawma = [(float)sgrt(beta - 0.75); F* always sqgrtinegative

194 1 -

4| 1 | b

2 Examine the source code.

Because beta is always less than 0.75, the argument to the sqrt () function
at line 193 is always negative.
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Example: A Function with No Errors

In the following example, Polyspace software verifies code with a large
number of iterations, and determines that the loop terminates and a variable
does not overflow:

1 In Procedural entities, click the green Non_Infinite Loop() function.

The source code view displays the source code for this function.

20LMCE O o
Example.c| 4 [ E
66 static int Non Infinite Loop (woid) -
67 ! const int big = 1073741821 ; /% 2%%30-3 +/

G int x=0, ¥=0;

69

70 while (1) [
71

72 {

73 if (¥ > big) { break:}

74 X o=x+ 2

75 ¥=x /%

76 1

77

TG ¥ == J 100;

79 return v;

aao 3 -
4 | 1] [ 3

2 Examine the source code. The variable x never overflows because the while
loop at line 70 terminates before x can overflow.

Example: Division by Zero
In the following example, Polyspace software detects division by zero:

1 In Procedural entities, expand Recursion().

The source code view displays the source code for this function.
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S OLIFCE o o

example.c| 4 - B3

137
138
139
140
141
142
143
144
145
146
147
145
149

static woid Recursion (int® depth)

A% if depth<0, recursion will lead to division by zero */
! float adwvance:

*depth = *depth + 1;
advance = 1.0f/(float) (*depth);: /% potential division by zera */

if (*depth < 50)
{
Recursion(depth) ;

'

static void Recurzion caller(wvoid)
{ int x=random int(); —

m

if ({xx-4) &6 (x £ -1)) &
i

Fecursion( &x 1: /4 always encounters a diwvision by zero

® = 10;
if (random_int() > 0)
i

Recursion( &x 1: S* never encounters a division by zero #/

[l | 2

2 Examine the Recursion() function.

When Recursion() is called with depth less than zero, the code at line 142
results in division by zero. The orange color indicates that this operation is

a potential error (depending on the value of depth).

3 Examine the red Recursion_caller function.

The first call to Recursion() at line 157 is red because it calls

Recursion() with depth less than zero, causing a division by zero. The
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second call to Recursion() at line 164 does not cause division by zero
because it calls Recursion() with depth greater than zero.

Filtering Checks

You can filter the checks that you see in the Results Manager perspective so
that you can focus on certain checks. Polyspace software allows you to filter
your results in several ways. You can filter:

® Run-time checks or coding rule violations

® Run-time checks by category (for example, ZDV, IDP, and NIP)

e Violations of selected coding rules

¢ Run-time checks by color (gray, orange, green)

e Justified or unjustified checks

® Checks by classification

® Checks by status

To filter checks, on the Results Explorer toolbar, select one of the following
filters.

- !

All checks | *F % % % Oy Oy

Tip The tooltip for a filter button indicates what the filter does.

Example: Filtering Coding Rule Violations

To hide all coding rule violations, on the Results Explorer toolbar, from the
drop-down list of the first filter, select Run-time checks.

;AII checks =]

All checks
Coding Rule violations
tun-Time checks

The software hides all coding rule violations and displays only run-time
checks.
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To filter violations of a specific coding rule:

CR
1 On the Results Explorer toolbar, click the coding rules filter icon | =¥ |.

2 From the drop-down menu, clear the check box for the coding rule, for
example, 5.4.

0

R C_ s
< I
Select All
Unselect All

2.2 - source code shall only use /™ .. ...

1]

34 - All uses of the #pragma directive ...

54 - Atag name shall be a unique ident...
5.6 - Mo identifier in one name space sh..
5.7 - Mo identifier narme should be reuse...

6.3 - Typedefs that indicate size and si...

I<Il<]l<]

The software does not display violations of this rule.
Example: Filtering IRV Checks

You can use an RTE filter to hide a given check category, such as IRV. When
a filter is enabled, you do not see that check category.

To filter IRV checks:

1 Expand Square_Root().

Square_Root () has five checks: four are green and one is red.

é--Sqda'a_?::l::
L IRV
" NIVLA1

§ sTo_LIBS

OV

RTE

2 Click the RTE filter icon | ™ .
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3 Clear the IRV option.

RTE CR C_ S
1 e g gt B
Select All

Unselect All

N O

L)

Z g
Z

A=
o 3
=

NRNRONRNE
¢
T

Ly
=l
L=

The software hides the IRV check for Square_Root ().

E}--Sq.ﬂ'a_?::lji
! ..... W HIVL1

4 Select the IRV option to redisplay the IRV check.

Note When you filter a check category, red checks of that category are not
hidden. For example, if you filter IDP checks, you still see IDP.9 under
Pointer_Arithmetic().

Example: Filtering Green Checks

You can use a Color filter to hide certain color checks. When a filter is
enabled, you do not see that color check.

To filter green checks:

1 Expand Square_Root().

Square_Root () has five checks: four are green and one is red.
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+*
2 Click the Color filter icon | =¥ .

3 Clear the Green Checks option.

C_ s

%y
Select All
Unselect All

Gray Checks
Qrange Checks
Green Checks

QOrange checks possibly impacted by inputs

The software hides the green checks.

Iél Square_Raoot | )

¥ sTO_LIBS
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Reviewing Results Systematically

In this section...

“Reviewing Checks at Level 0” on page 4-24
“Reviewing Checks at Levels 1, 2, and 3” on page 4-25

“Reviewing Checks Progressively” on page 4-27

Reviewing Checks at Level O

At this level, in addition to red and gray checks, you can focus on orange
checks that Polyspace identifies as potential run-time errors. These potential
run-time errors fall into three categories:

® Path — The software identifies orange checks that are path-related issues,
which are not dependent on input values.

® Path and bounded input — Default. In addition to orange checks that are
path-related issues, the software identifies orange checks that are related
to bounded input values.

e All — In addition to path-related and bounded input orange checks, the
software identifies orange checks that are related to unbounded input
values.

To specify the potential run-time error category for level 0:

1 In the Polyspace verification environment, select Options > Preferences.
The Polyspace Preferences dialog box opens.

2 Select the Review configuration tab.

3 From the Level drop-down list, select your category.

Ir'qh::u'ua -

Fath
Path and bounded input
All




Reviewing Results Systematically

The default is Path and bounded input. If you select None, the software
displays only red and gray checks.

4 Click OK to save your options and close the Polyspace Preferences dialog
box.

To select review level 0, in the Run-Time Checks toolbar, move the Review
Level slider to 0.

Reviewing Checks at Levels 1, 2, and 3

In addition to red, gray, and green checks, the software displays orange
checks according to values specified on the Review Configuration tab in the
Polyspace Preferences dialog box. See “Viewing Methodology Requirements
for Levels 1, 2, and 3” on page 4-26

You can use either a predefined methodology or a custom methodology to
specify the number of orange checks per check category.

To select a predefined methodology and review level:

1 From the Results Manager perspective, select Options > Preferences.
The Polyspace Preferences dialog box opens.

2 Select the Review configuration tab.

3 From the Methodology drop-down list, select, for example, Methodology
for C.

IMethudolugy for C -

Methodology for C
Methodology for C++
Methodology for Model-Based Design

4 Move the Review Level slider to the appropriate level, for example, level 1.
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Viewing Methodology Requirements for Levels 1, 2, and 3

In this part of the tutorial, you examine Methodology for C, which defines
the number of orange checks that you review at levels 1, 2, or 3.

To examine the configuration for Methodology for C:

1 In the Polyspace verification environment, select Options > Preferences.
The Polyspace Preferences dialog box opens.

2 Select the Review configuration tab.

3 From the Methodology drop-down list, select Methodology for C.

In the section Levels 1, 2, and 3, a table shows the number of orange
checks that you review for a given level and check category.

Levels 1, 2, and 3

Level 1 Level 2 Level 3
Common
2oV 5 2 ALL
MNIVL 10 50 ALL
S-OVFL 10 50 ALL
COR 10 10
NIV 1] 10
F-OVFL 5 10 20
ASRT 5 20
C & C++only
OBAI 10 20 ALL
SHF 3 10 ALL
IDP 10 20
NIP 10 20
STD_LIB
C only

IRV

w
[¥]

ALL

For example, the table specifies that you review five orange ZDV checks
when you select level 1. The number of checks increases as you move from
level 1 to level 3, reflecting the changing review requirements as you move
through the development process.

4 Click OK to close the dialog box.
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Reviewing Checks Progressively

3
On the Results Manager perspective toolbar, use the forward arrow to

move to the next unjustified check. The software takes you through checks
in the following order:

e All red checks
e All gray checks (the first check in each unreachable function).

¢ Orange checks — the number of orange checks is determined by the
methodology and review level that you select

Earlier in this tutorial, you selected Methodology for C, criterion 1. In this part
of the tutorial, you review the checks for example.c using this methodology

and criterion. To navigate through these checks:

1 Select the Results Summary tab.
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sults

Name File Justified

" IDP.8 example.c ] -
i NTC.3 example.c F
i [STD_LIB.4 example.c %7 =
o |UNR. 10 example.c il
2 |UNR.B example.c B |
i example.c [l

+ NIVL.O example.c [l

“# [ovFL.5 example.c =

? |OVFL.3 example.c [l

+ |OVFL.G example.c [l

? |ovFL.B example.c =
7 MISRACSE.3 include.h [l
v [MISRACE.3 include.h [
- |MISRACE.3 include.h (=]
7 MISRACSE.3 include.h [l
v |MISRAC 6.3 incude.h [
- |MISRACE.3 indude.h [}
7 MISRACE.3 include.h [l
v |MISRAC 6.3 incude.h [
- |MISRACE.3 indude.h [}
7 MISRACE.3 include.h [l
¥ |[MISRAC 16.3 include.h [
- |MISRACG.3 indude.h I}
7 MISRACE.3 include.h [l
v |MISRAC 6.3 include.h [
= IMICDArE 2 imeh 1A b =1 -

« | m 3
L Results Explorer | <& Results Summary
2 Click the forward arrow |L| to move to the next unjustified check.

The Source pane displays the source code for this check and the Check
Details pane displays information about this check.

Note You can display the calling sequence and track review progress, as
described in “Reviewing Results” on page 4-8.

3 Continue to click the forward arrow until you have gone through all of
the checks.

After the last check, a dialog box opens asking if you want to start again
from the first check.
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Wrapping search \EI

End of the set of checks under review.

Do you want to start again from the first check?

L Yes |[ No ]

4 Click No.
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Automatically Testing Unproven Code

Reviewing orange code to find true errors is a time-consuming task. You can
use the Automatic Orange Tester to automatically create and run test cases

to identify errors in the orange code. The workflow for using the Automatic
Orange Tester is:

1 Set an option to indicate that you want the software to run the Automatic
Orange Tester at the end of the verification.

2 Run the verification. The software uses results from the Automatic Orange
Tester to identify potential run-time errors.

3 If you want perform further dynamic tests on the code, run the Automatic
Orange Tester manually.

4 Review the results.

To learn how to use the Automatic Orange Tester, see “Automatically Testing
Orange Code” in the Polyspace Products for C/C++ User’s Guide.
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Generating Reports of Verification Results

In this section...

“Polyspace Report Generator Overview” on page 4-31

“Generating Report for example.c” on page 4-32

Polyspace Report Generator Overview

The Polyspace Report Generator allows you to generate reports about your
verification results, using predefined report templates.

The Polyspace Report Generator provides the following report templates:

Coding Rules Report — Provides information about compliance with
MISRA C Coding Rules, as well as Polyspace configuration settings for
the verification.

Developer Report — Provides information useful to developers, including
summary results, detailed lists of red, orange, and gray checks, and
Polyspace configuration settings for the verification. Detailed results are
sorted by type of check (Proven Run-Time Violations, Proven Unreachable

Code Branches, Unreachable Functions, and Unproven Run-Time Checks).

Developer Review Report — Provides the same information as the
Developer Report, but reviewed results are sorted by review classification
(High, Medium, Low, Not a defect) and status, and untagged checks are
sorted by file location.

Developer with Green Checks Report — Provides the same content as
the Developer Report, but also includes a detailed list of green checks.

Quality Report — Provides information useful to quality engineers,
including summary results, statistics about the code, graphs showing
distributions of checks per file, and Polyspace configuration settings for
the verification.

Software Quality Objectives Report — Provides comprehensive
information on software quality objectives (SQO), including code metrics,
code analysis (coding-rules checker results), code verification (run-time
checks), and the configuration settings for the verification. The code
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metrics section provides is the same information displayed in the Polyspace
Metrics web interface.

The Polyspace Report Generator allows you to generate verification reports in
the following formats:

e HTML

e PDF

e RTF

¢ DOC (Microsoft Word)
e XML

Note Microsoft Word format is not available on UNIX platforms. If you select
Word format on a UNIX platform, the software uses RTF format instead.

Generating Report for example.c

You can generate reports for any verification results using the Polyspace
Report Generator.

To generate a verification report:

1 If your verification results are not already open, open them.
2 Select Run > Run Report > Run Report.

The Run Report dialog box opens.



Generating Reports of Verification Results

Select Report Template

C:\PolySpace \PolySpace _CommonReportGenerator templates\CodingRules. rpt

C:\PolySpace\PolySpace_Common'\ReportGenerator \templates\Developer.rpt
C:\PalySpace\PolySpace_Common \ReportGenerator templates \DeveloperReview.rpt
Ci\PolySpace\PolySpace_CommonReportGenerator \templates\Developer _WithGreenChecks.rpt
C:\PolySpace\PolySpace_CommonReportGenerator templatesQuality. rpt
Ci\PolySpace\PolySpace_Common'\ReportGenerator \templates\SoftwareQualityObjectives.rpt

Browse...

Select Report Format
Output folder | C:\PolySpace\polyspace_project\Werification_1\R.esult_2\Palyspace-Doc m
Output format | RTF -

( Run Report @

Run Report l [ Cancel

3 In the Select Report Template section, select Developer.rpt.

4 In the Output folder section, select the \polyspace project folder.
5 Select PDF Output format.

6 Click Run Report.

The software creates the specified report. When report generation is
complete, the report opens.
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* “About Checking Compliance with Coding Rules Tutorial” on page 5-2
e “Setting Up Coding Rules Checking” on page 5-4
® “Running a Verification with Coding Rules Checking” on page 5-15
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About Checking Compliance with Coding Rules Tutorial

In this section...

“Overview” on page 5-2

“Before You Start” on page 5-3

Overview

Polyspace software allows you to analyze code to demonstrate compliance with
established C or C++ coding standards (MISRA C 2004, MISRA C++:2008,
or JSF++:2005).2

Applying coding rules can both reduce the number of orange checks in your
verification results, and improve the quality of your code. Coding rules are
the most efficient way to reduce orange checks.

To check compliance with coding rules, you set an option in your project and
then run a verification. Polyspace software finds the violations during the
compile phase of a verification. When you have addressed all coding rule
violations, you run the verification again.

For more information on the coding rules checker, see “Checking Coding
Rules”in the Polyspace Products for C/C++ User’s Guide

In this tutorial, you learn how to:

1 Create a second verification within your project.
2 Set an option for checking MISRA C compliance.
3 Select MISRA C rules to check.

4 Run a verification with MISRA C checking.

5 View coding rules violations using the Coding Rules perspective.

2. MISRA and MISRA C are registered trademarks of MISRA Ltd., held on behalf of the

MISRA Consortium.
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Before You Start

For this tutorial, you check the MISRA C compliance of the file example.c,
using the project that you created in Chapter 2, “Setting Up a Polyspace
Project”.
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Setting Up Coding Rules Checking

In this section...

“Opening Your Example Project” on page 5-4

“Creating New Module” on page 5-5

“Setting MISRA C Checking Option” on page 5-8

“Creating a MISRA C Rules File” on page 5-9

“Excluding Files from the MISRA C Checking” on page 5-12
“Configuring Text and XML Editors” on page 5-13

“Saving the Project” on page 5-14

Opening Your Example Project

For this tutorial, you modify the project in example.cfg to include MISRA C
checking. You use the Project Manager perspective to modify the project.

To open example project.cfg:
1 Select File > Open Project.
The Open a Polyspace project file dialog box opens.
2 Navigate to polyspace_project.
3 Select example project.cfg.

4 Click Open to open the file and close the dialog box.
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Creating New Module

A Polyspace project can contain multiple modules. Each of these modules can

verify a specific set of source files using a specific set of analysis options. In
this section, you create a second module to check coding rules compliance

for the example.c file.

To create a new module in example project:

1 In the Project Browser, select example_project [C].

2 Click the Create a new module icon

=

in the Project Browser toolbar.

A new verification, Module 2, appears in the Project Browser.

ALD|EAR S|+ ¥|3

Elg_',l example_project [C]
-3 Source
--EI Include
(3 Module_1
EJ 13 Source
=t 5 sources
i b | example.c
EJ l'j' Configuration
b E example_project
- lf' Result
: H-IES Result_1
E}E' Result_2 [Verification Completed]

E opticns

...... & Source

EI lﬂ Configuration
R E example_project

------ & Result

------ -] RTE_px_example_project_LAST_RESULTS.rte

3 In the Project Browser Source tree, right-click example.c, and select Copy

Source File to > Module_2
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The example.c file appears in the Source tree of Module (2).

'y Ejld‘l|“|t 4 | =

=3 U example_project [C]
L'—J@ Source
E\E sources
=] =ample.c
E- Include
E—J"@ Module_1
EIE' Source
| EHEF sources
H e || example.c
EI E‘ Cenfiguration
= [ example_project
B E‘ Result
"a Result_1
E}E' F{esult_l [Verification Completed]
4 opticns
------ RTE_px_example_project_ LAST_RESULTS.rte
=+ Module 2
-3 Source
E}E sources

i b . example.c
El B Configuration
H @ example_project

------ & Result

4 Right-click the Configuration folder in Module 2, and select Create New
Configuration.

5 Right-click the example project 1 configuration, and select Set as
Active Configuration.

The Project Browser now looks like the following figure.
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“" Project Browser

T RIEEEE

El‘Eﬁ example_project [C]
E}@ Source

E'ﬁ SOUrCes
----- | | example.c

-1 Include

I:-}-@ Module_1

E| B Source

= ﬁ sources

E| B Cenfiguration
- [T example_project
El 177 Result
.ﬁ Result 1
3 Result_2 [Verification Completed]
-3 Module_2
E| B Source
= ﬁ sources

E| B Cenfiguration

© - example projecl
-

...... & Result
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Setting MISRA C Checking Option

You set up MISRA C checking by setting an analysis option and then selecting
the rules to check. To set the MISRA C checking option:

1 Select the example project_1 configuration in the Project Browser.
2 Select the Configuration > All Settings tab.

3 Expand the Compliance with standards > Check MIRSRA C rules
node.

4 Select the Check MISRA C rules check box. The following options are
now available:

e MISRA C rules configuration
¢ Files and folders to ignore
e Effective boolean types

e Allowed pragmas

These options allow you to specify:

Which MISRA C rules to check

Files, if any, to exclude from the checking

Data types that you want Polyspace to consider as Boolean

Undocumented pragma directives for which rule MISRA C 3.4 should
not be applied.
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Creating a MISRA C Rules File

You must have a rules file to run a verification with MISRA C checking. You
can use an existing file or create a new one. You create a new rules file for
this tutorial by:

® “Opening a New Rules File” on page 5-9
e “Setting All the Rules to Off” on page 5-10
e “Selecting the Rules to Check” on page 5-10

Opening a New Rules File
To open a new rules file:

1 In the Project Manager perspective, select the Configuration > All
Settings tab.

2 Expand the Compliance with standards > Check MISRA C rules node.
3 Select the Check MISRA C rules check box.

4 From the MISRA C rules configuration drop-down list, select custom.

5 Click the button to the right of the MISRA C rules configuration
option.

A window for opening or creating a MISRA C rules file opens.
6 Select File > New File.

A table of rules appears. For each rule, specify one of the following states.

State Causes the verification to...

Error End after the compile phase when
this rule is violated.

Warning Display warning message and
continue verification when this rule
1s violated.

Off Skip checking of this rule.
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Note The default state for most rules is Warning. The state for rules that
have not yet been implemented is Off. Some rules always have a state of
Error (you cannot change this state).

Setting All the Rules to Off

In this tutorial, you check only a few rules. Therefore, first set the state of all
rules to Off. Later, you can select the specific rules that you want to check.

To set the state of all rules to Off:

1 From the Set the following state to all MISRA rules drop-down list,
select Off .

2 Click GO.

Selecting the Rules to Check

To select the rules to check for this tutorial:

1 Expand the set of rules named 16 Functions.

2 Select the Error column for 16.3.

3 Expand the set of rules named 17 Pointers and arrays.
4 Select the Warning column for 17.4.

The completed rules table looks like the following figure:
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File

o d

Set the following state to all MISRA C rules : :Error -

Rules Error Warning  Off
MISRA C rules -
-Mumber of rules by mode : 1 1 140 T

t|--1 Environment

H--2 Language extensions

£--3 Documentation

H-4 Character sets

H-5 Identifiers

£-G Types

#--7 Constants

-9 Initialisation

#--10 Arithmetic type conversions

t-11 Pointer type conversions

t--12 Expressions

+--13 Control statement expressions

H--14 Control flow

£
[E
[E
[E
[E
[E
[E
[+-8 Dedarations and definitions
[E
[E
[E
£
£
£
£

H--15 Switch statements

m

[=)--16 Functions

---16.1 Functions shall not be defined with variable numbers of arguments.

---16.2 Functions shall not call themselves, either directly or indirectly.

--16.3 Identifiers shall be given for all of the parameters in a function prototy

--16.4 The identifiers used in the dedaration and definition of a function shall

--16.5 Functions with no parameters shall be dedared with parameter type w

--16.6 The number of arguments passed to a function shall match the numbel

--16.7 A pointer parameter in a function prototype should be dedared as poi

--16.8 All exit paths from a function with non-void return type shall have an &

--16.9 A function identifier shall only be used with either a preceding &, or wi

--16,10 If a function returns error information, then that error information sh

[=]--17 Pointer and arrays

--17.1 Pointer arithmetic shall only be applied to pointers that address an arr; @

--17.2 Pointer subtraction shall only be applied to pointers that address elem @

--17.3 =, ==, <, <= shall not be applied to painter types except where they

--17.4 Array indexing shall be the only allowed form of pointer arithmetic.

--17.5 The dedaration of objects should contain no more than 2 levels of pair

---17.6 The address of an object with automatic storage shall not be assigned

[+-18 Structures and unions -

5 Click OK to save the rules and close the window.
The Save as dialog box opens.

6 In File, enter misrac.txt
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7 Click OK to save the file and close the dialog box.

Excluding Files from the MISRA C Checking

You can exclude files from MISRA C checking. You might want to exclude
some included files. To exclude math.h from the MISRA C checking of the

project example.cfg:

1 Select the Configuration > All Settings tab.

2 Expand the Compliance with standards > Check MISRA C rules or
Compliance with standards > Coding rules checker node.

3 Click the button to the right of the Files and folders to ignore
option. The Files and folders to ignore dialog box opens.

4 Click the folder iconi‘.

5 Navigate to the folder polyspace_project\includes.

6 Select the file math.h.

7 Click OK.

The file math.h appears in the list of files to ignore.

-=* Files and folders to ignore @
Files and folders to ignore [Hndudes-to-ignore]

C:VPolyspace\polyspace _projectiindudes\math.h

oK || cancel |

8 Click OK to close the dialog box.
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Configuring Text and XML Editors

Before you check MISRA rules, configure your text and XML editors in the
Polyspace Preferences dialog box. Configuring text and XML editors allows
you to view source files and MISRA reports directly from the Results Manager
perspective.

To configure your text and . XML editors:

1 From the Polyspace verification environment toolbar, select
Options > Preferences.

The Polyspace Preferences dialog box opens.

2 Select the Editors tab.

= Puolyspace Preferences @
Tools Menu | Review statuses | Assistant configuration I Miscellaneous | Character encoding -
Server configuration | Results folder | Editors | Generic targets

¥ML editor configuration

m

Specify the full path to & XML editor or use the browse button,

0]

¥ML Editor: C:\Program Files (x86) WMicrosoft Office\Office 12\EXCEL.EXE
Text editor configuration
Specify the full path to a text editor or use the browse button.

Text Editor: C:\Program Files\Windows NT\Accessorieswordpad exe

D)

Specify the command line arguments for the text editor,
Arguments: Wordpad  « | |SFILE

4 1 3

| OK || Apply || Cancel

3 Specify an XML editor to use to view MISRA-C reports. For example:

C:\Program Files\MSOffice\Office12\EXCEL.EXE

4 Specify a Text Editor to use to view source files from the Project Manager
logs. For example:
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C:\Program Files\Windows NT\Accessories\wordpad.exe

5 From the Arguments drop-down list, select your text editor to
automatically specify the command line arguments for that editor.

® Emacs

® Notepad++

e UltraEdit

® VisualStudio

* Wordpad

If you are using another text editor, select Custom from the drop-down
menu, and specify the command line arguments for the text editor.

6 Click OK.

Saving the Project

Save your project to save your new verification and analysis settings.
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Running a Verification with Coding Rules Checking

In this section...

“Starting the Verification” on page 5-15
“Examining MISRA C Violations” on page 5-16
“Opening MISRA-C Report” on page 5-19

Starting the Verification

When you run a verification with the MISRA C option selected, the software
checks most of the MISRA C rules during the compile phase.?

If there is a violation of a rule with state Error, the verification stops.
To start the verification:

1 In the Project Browser, select your project configuration, for example,
example_project_1.

2 On the Project Manager toolbar, click the Run button P Run .

The verification fails because of MISRA C violations. You see messages in

the Full Log, and the Output Summary indicates that the verification
has detected MISRA errors.

3. MISRA and MISRA C are registered trademarks of MISRA Ltd., held on behalf of the
MISRA Consortium.
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Examining MISRA C Violations
To examine the MISRA C violations:

1 In the Project Browser Result folder, double-click MISRA-C-report.xml.

The Results Manager perspective opens, displaying a list of MISRA C

violations.
- Polyspace - example_project C:\Polyspace\polyspace_project\Module_2\Result 1 = -E- ]
File Edit Run Review Options Window Help
HEeosd | 9 | & BB ‘ ' | @ ﬂ| 7] |Saard’\:‘ | 42 [0 Case sensitive[] whole word v| | %) Project Manager -7 Results Manager
.l‘é_‘]23m|[Me¢hndologyh|C v]ﬂ’lé P s
ResultsSurmary sex | thedoet ] RevewSlsis A
Name File Justified  Cld ég'ﬂﬁ b= No check currently selected| | Coding review progress Count  Progr...
W |MISRAC 16.3 incude.h [ No check selected nfa 0|
= |MISRAC 17.4 example.c [l Red justified / to justify 0/0 100
~ MISRAC 17.4 example.c [l Gray justified / to justify 0/0 100)
= ‘|Orange justified / to justify /o 100
~ |MISRAC 17.4 ! .
Example.c — “|Software reliability indicator /0 100]
| B Review Statistics | ¥ Check Review |
= Sore———————— e e Ry
o nsm 3¢
Veriables
example_project
4 [ m | b
. Results Explorer | - Results Summary £l I, 3
| 0% | Waiting for a command,

2 Click any violation to see a description of the violated rule, the full path of
the file in which the violation was found, and the source code containing
the violation.
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~* Polyspace - example_project C:\Polyspace\polyspace projectiMadule 2\Result 1 = EeE )|
File Edit Run Review Options Window Help

‘E B (=% H| L7 ‘ # By EE | % 9 “| 72 ‘Seard’\: - ,@ [ Case sensitive[ ] Whale word ¥ ‘l@ PfﬂJEHMBHEQEf

o1 |£_‘] z 3 s |Methodology for G -] B4 p P Cuisraciss

" Review Statistics

5" Results Summary

oaLLs

Name File ustfed il | % ] 5F include.h| | Coding review progress Count  Progr...

R . . MISRA C 16.3 justified | to justify [0/1 0
HIERREEE. o) — 33 extern void Exec_One Cycle (int): Justified | to justfy [0/

= MISRAC17.4  |example.c B Red justified / to justify 0o 100]

Sl R i ‘MISRA C 16.3 Tdentifiers shall be given for all of the parameters in a function protatype dedarstion. [Gray justfied | to justfy o0 100]

Sleci R = ‘|Orange justified | to Justfy o0 100]

= ‘|Software relisbilty ndicator [0/ 100]

| @ Review Statstics | ¥ Chedk Review |

" sotce ./ agmA[cdueady  a=x
|[[include.h EE @E
o . “ 1 cens
z8
29 int  random_int (veid);
30 float random_floativeid);
3l extern void partial_init{int *new_alt): | e m v
3z extern void RTE (woid); e — L ———————————
33 extern void Exec_Dne_Cycle (int); Varnke fecess e
34 extern int orderregulate (void): s 2
35 extern void Begin C5 (void): s Variables
36 extern void End CS (void): e e
37 extern void Increase_Powerlewel (woid):
38 extern int Ger_Powerlevel (woid):
< L | P as extern void Compute_Injection (woid);
-2 Results Explorer l-;" Results Summary J 40 hal | KT 4
| 0% | example_project  Source fieiincude.h  indudeh  Line:33 Column: 28

The log reports a violation of rule 16.3. A function prototype declaration in
include.h is missing an identifier.

3 In the Source pane, right-click the highlighted code containing the
violation of rule 16.3. From the context menu, select Open Source File.

The include.h file opens in your text editor.

Note Before you can open source files, you must configure a text editor.
See “Configuring Text and XML Editors” on page 5-13.
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5-18

Eu [ & = |include.h - WordPad

Home View
D Courier New 11 v A A

Paste B 7 U ae X |x|L- A S
Clipboard Font Paragraph

=]

#ifndef INCLUDE H
fdefine INCLUDE H

fdefine true 1
fdefine false 0O

fdefine checksum 1
#define new move 0
fdefine previous move 1

$define MAX SIZE 10

/* autcomatically stubbed functions */

extern int read bus status (void);
extern int error on bus(void);
extern int read on bus(void);

/* internal functions */

void initialise current_data(void);
void compute new coordonates (void);
void sort calibration(wveoid);

int polynomia (int input);

int random_int (veoid);

float random float(void);

extern void partial init(int *new_alt);
extern void RTE(wvoid);

extern void Exec One Cycle (int);

B R T B T B R B SR AR B SR

BN (B =X

=l ||| a8

Insert | Editing

€| 1

extern wvoid SEND_MESSAGE{int status, const char “*message);

7]

m

100% (=) -

J

4 Correct the MISRA violation and run the verification again.
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The verification then is completed, and the results will be the same as
those from the tutorial in Chapter 3, “Running a Verification”.

Opening MISRA-C Report
After you check MISRA rules, you can generate a report containing all the
errors and warnings reported by the MISRA-C checker.

Note Before you can open a MISRA-C report, you must configure an editor.
See “Configuring Text and XML Editors” on page 5-13.

To view the MISRA-C report:

1 Navigate to the folder that contains your coding rules report, for example,
C:\Polyspace\polyspace_project\Module 2\Result_ 1\Polyspace-Doc

2 Double-click the coding rules report, for example,
example project CodingRules.rtf. The report opens in your selected
editor.

5-19



5 Checking Compliance with Coding Rules

5-20



A

active project

definition 3-22

setting 3-22
analysis options 2-14

MISRA C compliance 5-8
ANSI compliance 3-10
AQT. See Automatic Orange Tester
Automatic Orange Tester

overview 4-30

C

call graph 4-12
call tree view 4-4
calling sequence 4-12
cfg. See configuration file
client 1-7 3-2
installation 1-12
verification on 3-27
coding review progress view 4-4 4-12
coding rules compliance 1-4
color-coding of verification results 1-4 to 1-5 4-5
compile log
Project Manager 3-12 3-29
Spooler 3-13
compile phase 3-10
compliance
ANSI 3-10
coding rules 1-4
MISRA C 5-1
configuration file
definition 2-3

D

default folder

changing location 2-7
division by zero

example 4-18

downloading
results 3-18

expert mode
filters 4-20

F

files
includes 2-11
source 2-11
filters 4-20
folders
includes 2-11
sources 2-11

H

hardware requirements 3-19
help
accessing 1-16

installation
Polyspace Client for C/C++ 1-12
Polyspace products 1-12
Polyspace Server for C/C++ 1-12

L

licenses
obtaining 1-12
logs
compile
Project Manager 3-12 3-29
Spooler 3-13
full
Project Manager 3-12 3-29

Index-1



Index

Spooler 3-13

stats
Project Manager 3-12 3-29
Spooler 3-13

viewing
Project Manager 3-12 3-29
Spooler 3-13

M

manual mode
selection 4-9
use 4-8

MISRA C compliance
analysis option 5-8
checking 5-1
file exclusion 5-12
rules file 5-9
violations 5-16

P

Polyspace Client for C/C++
installation 1-12
license 1-12

Polyspace In One Click
active project 3-22
overview 3-22
sending files to Polyspace software 3-24
starting verification 3-24
use 3-22

Polyspace products for C
installation 1-12
licenses 1-12
related products 1-17
workflow 1-13

Polyspace products for C/C++
components 1-7
overview 1-4
user interface 1-7

Index-2

Polyspace Queue Manager Interface. See Spooler

Polyspace Server for C/C++
installation 1-12
license 1-12
Polyspace verification environment
opening 2-5
preferences
Project Manager
default server mode 3-10
server detection 3-20
procedural entities view 4-4
product overview 1-4
progress bar
Project Manager window 3-12 3-29
project
creation 2-3 2-7
definition 2-3
file types
configuration file 2-3
folders
includes 2-4
results 2-4
sources 2-4
opening 3-4
saving 2-14
Project Manager

monitoring verification progress 3-12 3-29

opening 2-5
overview 2-5
perspective 2-5
starting verification on client 3-27
starting verification on server 3-10
viewing logs 3-12 3-29
window
progress bar 3-12 3-29
Project Manager perspective 1-7

R
related products 1-17



Index

Polyspace products for linking to Models 1-17

Polyspace products for verifying Ada
code 1-17
reports
generation 4-31
results
downloading from server 3-18
opening 4-3
report generation 4-31
reviewing 4-1
Results Manager perspective 1-7
call tree view 4-4
coding review progress view 4-4
opening 4-3
overview 4-4
procedural entities view 4-4
selected check view 4-4
source code view 4-4
variables view 4-4
rte view. See procedural entities view

S

selected check view 4-4
server 1-7 3-2
detection 3-20
information in preferences 3-20
installation 1-12 3-20
verification on 3-10
source code view 4-4
Spooler 1-7
monitoring verification progress 3-13

removing verification from queue 3-18

use 3-13
viewing log 3-13

T

target environment 2-13
troubleshooting failed verification 3-19

V)

unreachable code
example 4-16

v

variables view 4-4
verification
Ada code 1-17
C/C++ code 1-4
client 3-2
compile phase 3-10
failed 3-19
monitoring progress
Project Manager 3-12 3-29
Spooler 3-13
phases 3-10
results
color-coding 1-4 to 1-5
opening 4-3
report generation 4-31
reviewing 4-1
running 3-2
running on client 3-27
running on server 3-10
starting
from Polyspace In One Click 3-2 3-24
from Project Manager 3-2 3-10 3-27
stopping 3-31
troubleshooting 3-19
with MISRA C checking 5-15
Verification
stopping 3-30

w

workflow
basic 1-13
in this guide 1-14

Index-3



	toc
	Introduction to Polyspace Products for Verifying C/C++ Code
	Product Overview
	Polyspace Client for C/C++
	Key Features

	Polyspace Server for C/C++
	Key Features


	Polyspace Verification
	Overview of Polyspace Verification
	The Value of Polyspace Verification
	Ensure Software Reliability
	Decrease Development Time
	Improve the Development Process


	Product Components
	Polyspace Verification Environment
	Project Manager Perspective
	Results Manager Perspective

	Other Polyspace Components
	Polyspace Queue Manager Interface (Polyspace Spooler)
	Polyspace in One Click
	Polyspace Metrics Web Interface


	Installing Polyspace Products
	Finding the Installation Instructions
	Obtaining Licenses for Polyspace Client for C/C++ and Polyspace 

	Working with Polyspace Software
	Basic Workflow
	Tutorials in This Guide

	Additional Information and Support
	Product Help
	MathWorks Online

	Related Products
	Polyspace Products for Verifying Ada Code
	Polyspace Products for Linking to Models


	Setting Up a Polyspace Project
	About Setting Up a Project Tutorial
	Overview
	Example Files

	Creating a New Project
	What Is a Project?
	Preparing Project Folders
	Opening Polyspace Verification Environment
	Creating a New Project to Verify the Example C File
	Opening a New Project
	Specifying Source Files and Include Folders
	Specifying Target Environment
	Specifying Analysis Options
	Saving the Project



	Running a Verification
	About Running a Verification Tutorial
	Overview
	Before You Start

	Preparing for Verification
	Opening the Project
	Specifying Source Files to Verify
	Checking for Compilation Problems

	Starting Server Verification from Project Manager
	Starting the Verification
	Monitoring Progress of the Verification
	Monitoring Progress Using Project Manager
	Monitoring Progress Using Queue Manager

	Removing Verification Results from the Server
	Troubleshooting a Failed Verification
	Hardware Does Not Meet Requirements
	You Did Not Specify the Location of Include Files
	Polyspace Software Cannot Find the Server


	Using Polyspace In One Click to Launch Verification
	Overview of Polyspace In One Click
	Setting the Active Project
	Sending Files to Polyspace Software

	Launching Client Verification from Project Manager
	Starting the Verification
	Monitoring the Progress of the Verification
	Completing Verification
	Stopping the Verification Before It is Complete


	Reviewing Verification Results
	About Reviewing Verification Results Tutorial
	Overview
	Before You Start

	Opening Verification Results
	Opening Results Manager perspective
	Opening Verification Results

	Exploring Results Manager perspective
	Overview
	Reviewing the Results Explorer Tab

	Reviewing Results
	What are Review Levels?
	Displaying All Checks
	Reviewing All Checks
	Selecting a Check to Review
	Displaying the Calling Sequence
	Tracking Review Progress

	Reviewing Additional Examples of Checks
	Example: Unreachable Code
	Example: Arithmetic Error
	Example: A Function with No Errors
	Example: Division by Zero

	Filtering Checks
	Example: Filtering Coding Rule Violations
	Example: Filtering IRV Checks
	Example: Filtering Green Checks

	Reviewing Results Systematically
	Reviewing Checks at Level 0
	Reviewing Checks at Levels 1, 2, and 3
	Viewing Methodology Requirements for Levels 1, 2, and 3

	Reviewing Checks Progressively

	Automatically Testing Unproven Code
	Generating Reports of Verification Results
	Polyspace Report Generator Overview
	Generating Report for example.c


	Checking Compliance with Coding Rules
	About Checking Compliance with Coding Rules Tutorial
	Overview
	Before You Start

	Setting Up Coding Rules Checking
	Opening Your Example Project
	Creating New Module
	Setting MISRA C Checking Option
	Creating a MISRA C Rules File
	Opening a New Rules File
	Setting All the Rules to Off
	Selecting the Rules to Check

	Excluding Files from the MISRA C Checking
	Configuring Text and XML Editors
	Saving the Project

	Running a Verification with Coding Rules Checking
	Starting the Verification
	Examining MISRA C Violations
	Opening MISRA-C Report


	Index


